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OVRD is an Election Day modification to SOSA. How it is used and its special features are discussed.



SEIMS ONSITE VOTER REGISTRATION
DATABASE (OVRD) GUIDE

DISCLAIMER

The data contained in the screenshots of this document is test data and is for demonstration purposes only.

The SEIMS Onsite Voter Registration Database (OVRD) is used as an electronic poll book on Election Day at
voting precincts. There are two modes that can be used:

o LOCAL: Off site with no connectivity to the SEIMS Server

This mode is used if there is no available network connection from the satellite voting location to the
county database server, and is the default for OVRD use. It allows the user to look up registered voters for
the county for a specific election on a local machine. The user may also perform registration changes and
cast votes for registered voters that are allowed to vote in the given election. The activity is stored locally
and must be transferred manually on a portable media device through a data file export/import
methodology.

e SITE SERVER: Off site with a LAN connection to all machines

This mode is used if the Client/Server functionality for OVRD has been set up at the voting site. It allows
one machine to act as a server and all other machines to act as clients. All client machines share the
database installed on the Server machine, instead of the locally installed database. Essentially, this allows
the clients and the server machine to function as “one” machine. All other OVRD functionality remains the
same.

This document will describe how to use OVRD. It will also give step-by-step instructions on how to do basic
tasks.
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CHAPTER 1: GETTING STARTED

SECTION 1: OVERVIEW

The Onsite Voter Registration Database (OVRD) is the Election Day voting application. Once a SEIMS One-
Stop Voting Application (SOSA) machine is converted to OVRD, it can be used on Election Day at the polling
place. OVRD’s purpose is to be an electronic version of a poll book at the polls - registrations listed by
alphabet and only one vote allowed.

The usage of OVRD is almost the same as using SOSA, with the exception of the following:

1. The application will reference OVRD instead of SOSA.

2. OVRD machines do not need to be validated.

3. Election Sites for OVRD are precincts instead of one-stop sites.

OVRD only runs in LOCAL mode, or SITE SERVER mode if a LAN is being used at the polling site.

A unique 3-digit machine ID must be created in order to use Provisional Voting in OVRD.

SN L

OVRD allows a registrant to vote only once on a given machine, even if cancelled. This is because of
the irretrievability of the ballot.

Notes cannot be added to a vote.

Reason registrant can’t vote displays in the bottom right section of the screen. Reasons are: Cannot
Vote Has Previously Voted, Cannot Vote Not in Precinct, Inactive Voter Verify Registration
Information, and Cannot Vote Not in Alphabet Range.

9. Search results in OVRD will not display SDR voters as these newly registered voters are not allowed to
show up on a poll book for Election Day.

10. Pending Applications in VoterScan Review/I-Queue can be searched using the Pending Applications
radio button on the search screen.

11. Instead of an Absentee Application printing when a registrant is voted, a populated ATV form and an
OVRD Transaction Receipt (if EPB: PRINT OVRD TRANSACTION REPORT is set to ‘Y’) will print.

12. If a vote is cancelled, a Transaction Receipt will print indicating the cancel (if EPB: PRINT OVRD
TRANSACTION REPORT is set to ‘Y’).

13. A ‘Transfer to BOE’ can only be run ONCE; preferably at the end of voting on Election Day.
14. Voters can be flagged as having voted absentee.
15. Voters can be flagged as having been transferred.

Outside these exceptions, the OVRD application looks like SOSA Voting and is used like SOSA Voting.
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SECTION 2: LOG-IN PROCEDURE

Use the following steps to start-up and log into the OVRD application.

85! SEIMS+ Authentication X
1. From the computer desktop, double-click the SOSA Voting icon and OV
the SOSA/OVRD Voting authentication window will appear, as i
shown in the image to the right. eburton
Password
2. Each user must enter their unique User ID and password for the '_”
installed Environment; either ‘Production’ or ‘Training’. Select a \E;VgSCETEN |
Location of Local or Site Server (if a LAN has been set up). eaion
LOCAL -
:
NOTE: OVRD only allows the LOCAL or SITE SERVER location TR
types.

3. Click the Login button. The OVRD Voting Information popup
appears, as shown to the right. Review the information.

If the OVRD Voting Information popup appears with the
information shown in red, refer to the Administrator
Guide to select an Election Site, Machine ID and Alphabet
Range.

If Provisional Voting is allowed on the machine, a ‘Y’
indicator will display in the lower right of the screen.

OVRD Voting Information

Election Date: 03/07/2017

Election Site: [NOT SELECTED]
Machine: SBEWKO1RM108
Machine ID: [NOT SELECTED]

AlphabetRange: [NOT SELECTED]

MBSN: 270%02FEAD17F08E49B43561BECED3FS
GUID:  00000000-0000-0000-0000-000000000000

Status

The following issue(s) need to be dealt with:
|[1] No election site selected.

[2] Ne alphabet range selected.

Provisional Voting
Allowed:

4. Click the OK button. The main screen appears, as shown
below.
- 1
[0 dmmeiasiun | H- a o | & & - %
Search Cribees.
Last Nams. Firat Nama Middia Nama D08 (MMDOYYYY) _r!l*
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SECTION 3: OVRD OPTIONS

OVRD has several different settings that can be used to optimize the application according to the county
needs. Most of these options should have been set by the administrator, but those settings may be changed if

the situation warrants it. To open g oo options
the options screen, click on File >
Options in SOSA. The screen to
the right will display.

= | = P
Defaults Import
Election Site Name Default File Location
|16 HIGHLAND - HIGHLAND RECREATION CENTEF ~ El
File Name Prefix
[¥] Allow Curbside Vating 0SVDB
¥] Allow Provisional Voting
Default Voting Method Machine ID Export
IN-PERSON - B12 Default File Location
E:\ Browse...
v] Allow users to search pending applications = . " B
[#] Allow users to enter Election Day Transfers CI);V[?E';E)E X
Printing
Printer Type # of Application Copies OWVRD Valid Alphabet Range
& Application (8.5% 11} Select an alphabet range to allow only voters with last names
ONE B that are included in this range.
" None
Start End
A Z
Current Printer
W\sbebwk03rm133\HP LaserJet P1505n

The OVRD options are described below.

OVRD SITE PROPERTIES

Defaults

Election Site Name

Indicates the polling place to which this machine is assigned.

Allow Curbside Controls whether or not curbside voting is allowed in the application.
Voting

Allow Provisional Enables Provisional voting functionality in the application.
Voting

Default VVoting Sets the default voting method for OVRD.

Method

Machine ID Allows entry of a 3-digit unique machine ID (See Section 4).

Allow Users to
Search Pending
Applications

Allows a search for registrants with pending applications (in VoterScan) that have not yet been
processed.

Allow Users to enter
Election Day
Transfers

Allows the user the ability to record the transfer, print out an ATV form with the transfer section filled
out and vote the person. In addition, the user will have the ability to mark a person as “voted” if
another polling place calls and states that a voter had voted at their polling place.

Printing

Printer Type

Sets the type of paper to print documents within OVRD. Forms can be printed on a standard
printer (Application 8.5x11) or nothing at all (None). If standard paper is not selected, the OVRD
reports will not be available.
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OVRD SITE PROPERTIES

# of Application
copies

Set the number of copies of the absentee application to print. One to five copies of the Absentee
Application can be printed. One is the default.

Current Printer

Only displays the default printer for the machine. To change this, the user must change the
default printer in Windows.

Test Print button

The function allows the user to send a test page to the default printer to make sure it is working
correctly.

Enable Print This option is only available when running SOSA against a Training database (instead of
Preview Production). This will allow all documents that normally go straight to the printer, to preview on-
screen. A print button is available on the preview window if it is decided to actually print the
document. This will help save paper during training sessions.
Import
Default File Allows the user to change the default location OVRD uses to find import (Transfer Data to/from
Location BOE) files. Click the Browse button to select a different file location.

File Name Prefix

Only displays the import file name prefix. All import files should start with the characters
OSVDB.

Export

Default File
Location

Allows the user to change the default location OVRD uses to place export (Transfer Data to/from
BOE) files. Click the Browse button to select a different file location.

File Name Prefix

Only displays the export file name prefix. All export files will begin with the characters OSV.

OVRD Valid Alphabet Range

Start Allows the user to set the range of names that will be allowed to vote on that machine. If only one
machine is used at a site, this can be set to A to Z. Otherwise the alphabet can be split, e.g. “A-L” or”
M-Z”.

End Allows the user to set the range of names that will be allowed to vote on that machine. If only one

machine is used at a site, this can be set to A to Z. Otherwise the alphabet can be split, e.g. “A-L” or”
M-Z”.
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SECTION 4: SETTING MACHINE ID

In order to use Provisional Voting in OVRD, a unique Machine ID must be set. Because OVRD machines cannot
be validated like SOSA machines, the unique code must be set to identify each individual machine. The 3-digit
code cannot be the same as any One-Stop site codes and it cannot start with the number O (as those are
reserved by the system). It is recommended that the code begin with a letter followed by 2 numbers, for
example, “B01, B02, C01 C02, etc.” If a ‘Machine ID’ is not already set, please contact your system
administrator.

NOTE: The county must be diligent in keeping track of the codes set for each machine as duplication
of machine IDs will cause problems with duplicate PIN and Poll book numbers.
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CHAPTER 2: SEARCHING

SECTION 1: OVERVIEW

In OVRD, searching is the critical function needed to find the voter who wishes to participate in Election Day
voting. Itis used to look registered voters up to be able to process votes, registration changes, or even look up
their current information. Furthermore, there is a feature to allow the searching of pending applications, in
case a voter mentions they registered on time and questions why they cannot be found.

SECTION 2: OVRD MAIN SCREEN

Below is the main OVRD Voting screen. The top section of the screen displays all of the criteria fields
available for searching and two ribbons (Home and Tools) that contain all of the function buttons. The center
of the screen displays the search results in a grid, and the bottom section displays registration and/or vote
information for a selected voter. An explanation of the available functions can be found in the table below.

@' = OVRDVoting (v.2.3.22) - LOCAL p) - EBurton - 11/08/2016 GENERAL - Mach:SBEWK01RM108 - Site:CH-B = 2 =

r— P
Nelwom: JEEomr & & | & & & & B

[[] Show Removed Voters4 “ & Rep Flag as Transfe e
Search  Clear ate Update View Mew Voter  Existing 5 it Print
1 o 2 | VoterReg Voter Reg Prov Voter Prov  Prg Referral =
Search = Voting Registration 1 12 13 Provisional Voting L

Search Criteria

Last Name First Name Middle Name DOB (MM/DD/YYYY)
[BURTON | | J =i

Potential Volers (62 rows)
Name Address Mail Addr Ballot Style Party Gender Race DOB B

»

i BURTON, AMANDA PATE 126 COCO LN STATESVILLE, NC 28625 G003 UNA FEMALE WHITE 10/14/1983
BURTON, ANNIKA SHEREE 128 BURKE CIR MOORESVILLE, NC 28115 G014 DEM FEMALE BLACKOR |10/11/1980
BURTON, BARBARA LEE 368 CHESTNUT GROVE RD STATESVILLE, NC 28625 fehils} UNA FEMALE WHITE 06181970 E
BURTON, BETTY JEAN 380 MEDLIN ST STATESVILLE, NC 28677 Gom DEM FEMALE BLACKOR |09/01/1940
BURTON, BETTY WILLIAMS 323 CALDWELL AVE MOORESVILLE, NC 28115 G014 DEM FEMALE WHITE 04/04/1932
BURTON, BRANDI NICHOLE 150 LIPPARD FARM RD STATESVILLE, NC 28625 G009 UNA FEMALE WHITE 10/08/1983
BURTON, CAROLYN 5 2175 DEER VIEW CIR # 601 STATESVILLE, NC 28625 Gomn DEM FEMALE BLACKOR |05/02/1945 I
BURTON, CATHY WCQCODS 109 BEACH LN MOCRESVILLE, NC 28117 G014 REP FEMALE WHITE D5/26/1953
BURTON, CHARLES FLOYD Il 1108 CLAY ST STATESVILLE, NC 28677 G012 DEM MALE BLACKOR |09/25/1980
BURTON, CLYDE PAUL JR 109 BEACH LN MOORESVILLE, NC 28117 G014 REP MALE WHITE 07/26/1953
BURTON, CONSTANCE LEE 276 OVERHEAD BRIDGE RD MOCRESVILLE, NC 28115 G014 DEM FEMALE WHITE 077211945
BURTON, CRAIG RAYMOND 129C IRVING AVE MOORESVILLE, NC 28117 G014 REP MALE WHITE 12/24/1983
BURTON, CURTIS AUSTIN 128 LIPE RD TROUTMAN, NC 28166 G007 REP MALE WHITE 09/18/1990
BURTON, DARIN KEITH 388 EWILSON AVE MOORESVILLE, NC 28115 G014 UNA MALE WHITE 05/031970
BURTON, DARREN DOUGLAS JR 1313 SCHOOL ST STATESVILLE, NC 28677 X G010 DEM MALE BLACK OR |02/08/1965
BURTON, DARRIUS R 1313 SCHOOL ST STATESVILLE, NC 28677 G010 DEM MALE BLACKOR |02/08/1965
BURTON, DEANNA B 821 PARK DR STATESVILLE, NC 28677 G010 UNA FEMALE BLACKOR |06/09/1966
BURTON, DELLA MARIE 324 WMCNEELY AVE # F MOORESVILLE, NC 28115 G014 REP FEMALE WHITE 01/23/1954
BURTON, DILLON MICHAEL 427 BRANCHWOOQD RD STATESVILLE, NC 28625 G003 REP MALE WHITE 09/02/1995
BURTON, DONALD ONEIL 285 LAKE MIST DR MOORESVILLE. NC 28117 G014 UNA MALE WHITE 01/21/1950
BURTON, EVELYN 1013 WALL ST STATESVILLE, NC 28677 G2 DEM FEMALE BLACKOR |03/01/1951
BURTON, FRAMCES DANIEL 294 CHESTNUT GROVE RD STATESVILLE, NG 28625 G006 DEM FEMALE BLACKOR |01/10/1958
BURTON, GAIL HALL 139 BARNSWALLOW LN MOORESVILLE, NC 28115 G013 DEM FEMALE BLACKOR |01/27/1950
BURTON, HARRIET IRENE 307 GRAY ST STATESVILLE, NC 28677 Gon DEM FEMALE BLACKOR |06/14/1956

Z  VRN: 000001184200 ACTIVE ST6/STE CANNOT VOTE e

= BURTON, ALONZO JR NOT IN PRECINCT

2| 1013WALLST
g STATESVILLE. NC 28677
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OVRD SCREEN FUNCTIONALITY

#  Button Name Description
1 Search Searches the county database for potential voters then displays the results in the Potential VVoters
grid.

2  Clear Clears all fields of data

3 More Criteria Displays address fields for searching

4  Show Removed Allows the user to toggle whether or not Removed/Denied voters appear in the search results
Voters

5 Vote Populates the right Voter Information Panel with VVoted and updates the voter to indicate they have

voted in the selected election.

6 Cancel Vote Opens the Cancel Vote screen to cancel a vote performed on the same machine in error.

7  Reprint Re-print the voter application to the designated printer.

8 Flagas Absentee  Flag the selected voter as having returned an absentee ballot.

9 Flagas Transfer  Flag the voter as having voted in another precinct.

10 Update Voter Reg  Open the Edit Registration popup to begin editing voter information.

11 View Voter Reg Opens the Voter Registration popup so the user can review the voter information in detail.

12 New Voter Prov Allows a new provisional voter to be added (non-exiting registrant).

13 Existing Voter Allows adding a provisional vote to an existing registered voter.
Prov

14 View Prov Allows viewing the provisional vote entered on this machine.

15 Reprint Allows the reprinting of Provisional forms to the designated printer.

16 Print Referral Allows the printing of a blank Help Referral Form or a pre-populated form for a selected voter.

OVRD User Guide
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SECTION 3: VOTER SEARCH

In the Search Criteria section of the OVRD main screen, there are criteria fields that may be used to find a
specific voter. The default search fields are Last Name, First Name, Middle Name and DOB (MM/DD/YYYY).
To display address search fields of House #, Dir, Street Name, Type, Suffix, Unit, City, State, and Zip Code,
simply click the ‘More Criteria’ checkbox on the Home ribbon. The user may use any combination of the
search criteria fields. Using a combination of search options will return more defined results in the Potential
Voters Grid. A wild card (%) may be used in the name fields to allow for find a variety of potential matches,
especially if the spelling of the name is not known. Any results found will be displayed within the Potential
Voters grid found below the Search Criteria section.

The below example shows the steps to a simple name search:

1. Enter the voter’s last name in the ‘Last Name’ field, e.g. “SMITH”. If the user is unsure of the spelling of
the voter’s last name (SMITH vs. SMYTH), the wildcard symbol (%) can be used to ensure all spellings
of the name are located (e.g. “SM%TH”).

Enter the voter’s first name in the ‘First Name’ field, e.g. “DAISY”.

Click ‘Search’ or press ‘Enter’. Alternatively, click the Barcode Scan icon to the right of the DOB field to
scan an NCDL barcode from a voter’s driver’s license which will prevent the need for manual data
entry in the search fields.

A search on just a voter’s last name can be Search Error %
used. However, to speed up the search and
reduce the number of voters located, it is I.-"'_"‘-.I More than 500 voters would be retrieved from the criteria chosen.
best to use both the first and last name of @' Please narrow your search.

the voter. If more than 500 results are
going to be returned, a message displays to oKk
narrow the search. Click ‘OK’ to clear the

message and begin the search again.

The results will populate in the Potential Voters section of the main screen, as shown below.

Search Criteria

Last Name _ First Name  Middle Name ~ DOB (MM/DDIYYYY) I
BURTON |~ =
Potential Volers (62 rows)
Name Address Mail Addr Ballot Style Party Gender Race DoB
|J| BURTON, ALONZO JR 1013 WALL ST STATESVILLE, NC 28677 BLACKOR 02/01/1945
BURTON, AMANDA PATE 126 COCO LN STATESVILLE, NC 28625 G003 UNA FEMALE WHITE 10/14/1983

If the voter’s name cannot be found, try the following:

o Verify the spelling of the name.
e Verify there is no name change.

e Search using only a portion of the voter’s last name and first name, such as the first few letters
and add the wildcard symbol (%) at the end.

Example: ‘Last Name’: “SM%” ‘First Name’: “D%”, this will find all voters with last names
beginning with “SM”, and first names beginning with “D”.
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e Search using other criteria fields instead, such as ‘Street Name’ or ‘DOB (MM/DD/YYYY)'. The
‘More Criteria’ and ‘Show Removed Voters’ check boxes on the Home tab will give you more
search options.

If the voter cannot be found, follow the process defined by the County Board of Elections. The voter
may need to vote a Provisional ballot.

SECTION 4: VOTER INFORMATION OVERVIEW

Upon performing a successful search that returns a list of voters, the OVRD main screen will display that list
of voters within the Potential Voters grid, along with any provisional records entered on the machine; a
sample of which is shown below. Each voter record will display the information as defined in the grid below.

Potential Voters (21 rows)

Name Address Mail Addr Ballot Style Party Gender Race DOB

TATE. ALAN DEAN 155 LONGWOOD DR STELLA, NC 28582 NOBALLOT REP MALE WHITE 12/241962
TATE. ANDREA PATRICIA 1ASTCAMP LEJEUNE, NC 28542 X G004 DEM FEMALE BLACKO |03/17/1992
TATE. BARBARA THOMPSON 117 LINDA LOOP JACKSONVILLE, NC 28546 G004 DEM FEMALE BLACK O |08/06/1959
TATE. BRITTNEY LYNN 415 JOHN DEER CT RICHLANDS, NC 28574 NO BALLOT REP FEMALE WHITE 09/231947
TATE. CAROLYN 1241 ONSLOW FINES RD JACKSONVILLE, NC 28540 NO BALLOT UNA FEMALE WHITE 05/03/1994
TATE. CONSTANCE 2022 TARAWA BLVD TARAWA TERRACE, NC 28543 G004 UNA FEMALE WHITE 06/18/1927
TATE. DARRELL LENIER 500 TOWER DR JACKSONVILLE, NC 28546 NOBALLOT DEM MALE BLACKO |01/1711962
TATE. DARRELL LENIER JR 500 TOWER DR JACKSONVILLE, NC 28546 NO BALLOT DEM MALE BLACKO |02/04/1936
TATE.JEFFREY DAVID 210 PORT SIDE DR SNEADS FERRY. NC 28460 NO BALLOT UNA MALE WHITE 05/01/1974
TATE. JENNIFER LEANN 915 MORGANSER DR SWANSBORO, NC 28584 G007 UNA FEMALE | WHITE 08/24/1934
TATE. JOHN DELACY 111 LINDA LOCP JACKSONVILLE, NC 28546 G004 DEM MALE BLACK O |02/15/1959
TATE. KENNETH ALLAN 210 PORT SIDE DR SNEADS FERRY, NC 23460 NO BALLOT UNA MALE WHITE 06/23/1931
TATE. KENNETH HARCLD Il 104 RAVENWOOD DR # C JACKSONVILLE. NC 28548 G004 UNA MALE OTHER 101411980
TATE. LORENZA NORRIS JR 507 LAKEWOOD DR JACKSONVILLE, NC 28546 G004 UNA MALE BLACKO |03/16/1939
TATE. MICHAEL ARTHUR 204 EGRET POINT DR SNEADS FERRY, NC 28460 NOBALLOT UNA MALE WHITE 05/07/1982
TATE. RACHEL ELIZABETH 130 ABERDEEN LN JACKSONVILLE, NC 28540 NC BALLOT UNA FEMALE WHITE 01/2111984
(3 TATE. RODNEY QUINTELL 507 LAKEWOOD DR JACKSONVILLE, NC 28546 G004 UNA MALE BLACKO 10/28M1958
TATE. SANDRA ANA-MARIE 500 TOWER DR JACKSONVILLE, NC 28548 NO BALLOT UNA FEMALE TWOOR | 03/25M1955
TATE. SANTINA MARIE 500 TOWER DR JACKSONVILLE. NC 28546 NOBALLOT DEM FEMALE |BLACKO |09/02/1933
TATE. TIMOTHY NICHOLAS 126w BAYSHORE BLVD JACKSONVILLE, NC 28540 G004 UNA MALE WHITE 08/03/1950
TATE. TRACEY ANN 126 W BAYSHORE BLVD JACKSONVILLE, NC 28540 G004 REP FEMALE WHITE 11/03/1963

POTENTIAL VOTERS GRID COLUMN DEFINITIONS

# Column Name Description

1 Name The full name of the registered voter presented as last name first.

2 Address The residential address of the registered voter.

3 Mail Addr Indicates the registrant has a mailing address by displaying an X’ in the column.

4 Ballot Style The ballot style of the registered voter.

5 Party (Voted Party) Opens the Voter Registration screen in read-only mode so the user can review the voter
information in detail.

6 Gender The gender of the registered voter.

7 Race The race of the registered voter.

8 DOB The date of birth of the registered voter.

Note: Do NOT give a voter’s date of birth to another person for any reason, as by law, this
information is confidential!

When a voter’s record is selected, additional information for the selected voter will appear at the bottom of
the window on the Voter tab.
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VOTER INFORMATION PANEL

The Voter Information Panel displays information about the selected voter’s registration, separated into the
Voter tab and the Changes tab. The voter’s registration information appears on the left side of the Voter tab
and the voter’s vote status appears on the right side of the Voter tab. If the selected voter has previous vote
activity, information will display, if they have no activity, the area will be empty. If any registration changes
have been made to the selected registrant, they will appear on the Changes tab.

C = # =
Home | Tools o
ﬂ ’ [ More Criteria L a‘ & % % Ef,’ ﬁ %
[F]  Show Removed Voters e
Search  Clear ote Update View Mew\Voter  Existing  View  Reprint Print
- VoterReg  Voter Reg Prov  VoterProv  Pro Referral
Search Voting Registration Provisional Voting
Search Criteria
Last Name First Name Middle Name DOB (MM/DD/YYY
(sinron [ ) | |
Potential Volers (62 rows)
Name Address Mail Addr Ballat Style Party Gender Race DOB e
:
|| BURTON, AMANDA PATE 126 COCOLN STATESVILLE, NC 28625 G003 UNA FEMALE | WHITE 10/14/1983
BURTON, ANNIKA SHEREE 128 BURKE CIR MCORESVILLE, NC 28115 G014 DEM FEMALE  |BLACKOR [10/11/1920
BURTON, BARBARA LEE 368 CHESTNUT GROVE RD STATESVILLE, NC 28625 G006 UNA FEMALE | WHITE 06/18/1970 E
BURTON. BETTY JEAN 380 MEDLIN ST STATESVILLE. NC 28677 G011 DEM FEMALE  [BLACKOR [09/01/1940
BURTON. BETTY WILLIAMS 323 CALDWELL AVE MOCRESVILLE, NC 28115 G014 DEM FEMALE | WHITE 04/04/1932
BURTON, BRANDI NICHOLE 150 LIPPARD FARM RD STATESVILLE, NC 28625 G009 UNA FEMALE | WHITE 10/09/1983
BURTON, CAROLYN S 2175 DEER VIEW CIR # 601 STATESVILLE, NC 28625 Go11 DEM FEMALE  |BLACKOR |05/02/1945
BURTON, CATHY WOODS 109 BEACH LN MOCRESVILLE, NC 28117 G014 REP FEMALE | WHITE 05261953
BURTON. CHARLES FLOYD Il 1108 CLAY ST STATESVILLE, NC 28677 G012 DEM MALE BLACKOR |09/25/1930
BURTON. CLYDE PAUL JR 109 BEACH LN MOCRESVILLE, NC 28117 G014 REP MALE WHITE 077261953
BURTON. CONSTANCE LEE 276 OVERHEAD BRIDGE RD MOORESVILLE, NC 28115 G014 DEM FEMALE | WHITE 0712111945
BURTON, CRAIG RAYMOND 129C IRVING AVE MCORESVILLE, NC 28117 G014 REP MALE WHITE 1272411983
BURTON, CURTIS AUSTIN 128 LIPE RD TROUTMAN, NC 28166 G007 REP MALE WHITE 00/18/1990
BURTON. DARIN KEITH 388 E WILSON AVE MOORESVILLE. NC 28115 G014 UNA MALE WHITE 05/03/1970
BURTON. DARREN DOUGLAS JR 1313 SCHOOL ST STATESVILLE. NC 28677 X G010 DEM MALE BLACKOR |02/08/1965
BURTON. DARRIUS R 1313 SCHOOL ST STATESVILLE. NC 28677 G010 DEM MALE BLACKOR |02/08/1965
BURTON, DEANNA B 821 PARK DR STATESVILLE, NC 28677 G010 UNA FEMALE  |BLACKOR |06/09/1966
BURTON, DELLA MARIE 324 WMCNEELY AVE # F MOORESVILLE, NC 28115 G014 REP FEMALE | WHITE 01/23/1954
BURTON. DILLON MICHAEL 427 BRANCHWOOD RD STATESVILLE, NC 28625 G003 REP MALE WHITE 09/02/1995
BURTON. DONALD ONEIL 285 LAKE MIST DR MOORESVILLE, NC 28117 G014 UNA MALE WHITE 01/21/1950
BURTON. EVELYN 1013 WALL ST STATESVILLE. NC 28677 G012 DEM FEMALE  |BLACKOR [03/01/1951
BURTON, FRANCES DANIEL 294 CHESTNUT GROVE RD STATESVILLE, NC 28625 G006 DEM FEMALE  |BLACKOR |01/10/1958
BURTON, GAIL HALL 139 BARNSWALLOW LN MCORESVILLE, NC 28115 G013 DEM FEMALE  |BLACKOR [01/27/1950
BURTON. HARRIET IRENE 307 GRAY ST STATESVILLE, NC 2867 Go11 DEM FEMALE  |BLACKOR |06/14/1956
VRN: 000001184200 ACTIVE STB/STE CANNOT VOTE

BURTON, ALONZO JR
1013 WALL ST
STATESVILLE. NC 28677

NOT IN PRECINCT

Descriptions of the registered voter’s information and when it is displayed, as well as a magnified version of
the panel, is presented below.

Magnified Voter Information Panel

T
o
=

VRN: 000001184200
BURTON, ALONZO JR

1013 WALL ST
STATESVILLE, NC 28677

ACTIVE

STE/STE

CANNOT VOTE
NOT IN PRECINCT
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INFORMATION THAT APPEARS IN THE VOTER INFORMATION PANEL

Tab Type Condition Value
Voter VRN Appears when the voter is a registered voter. Displays the voter’s voter registration
(left) New registrants will have a blank value. number in the county.
Voter Name Always displays. Displays voters’ name as:
(left) Last Name, First Name, Middle Name
Voter Address Always displays. Mailing address will display if Displays voters’ residential address.
(left) Mail Addr column contains an X.
Voter PCT/VTD Always displays. Displays the Precinct and VTD
(left) associated with the voters’ registered
residential address.
Voter Status Always displays. Displays the current status of the
(left) registered voter:
Active, Inactive, Removed, Denied,
Temporary
Voter No Ballot Red exclamation triangle icon displays indicating &
(right) the selected registrant has no ballot for the No Ballot Style
election.
Voter Can Vote Green checkmark icon displays indicating the
(right) sele(fted registrant is eligible to vote in the OVRD Green check mark
precinct.
Voter Cannot Vote  Displays in OVRD mode when a voter is not
(right) registered in the precinct in which they have Not In Precinct
appeared to vote. Black and red “no” icon displays.
Voter Cannot Vote  Displays in OVRD mode when a voter presents
(right) themselves to a poll worker and the computer does Nt in Alphabet Range
not have the alphabet range of the voters’ Last
Name. Black and red “no” icon displays.
Voter Cannot Vote  Displays in OVRD mode when a voter presents Transferred to [Precinct Name] Precinct
(right) themselves at a precinct to vote when they have
been transferred to another precinct. Black and red
“no” icon displays.
Voter Cannot Vote  Displays in OVRD mode when a voter presents
(right) themselves at a precin.ct to vqte Wh(?n they have an Flagged as Voted Absentee
absentee record associated with their Last Name .
Black and red “no” icon displays.
Voter Cannot Vote  Displays in OVRD mode when a voter presents 6
(right) themselves at a precinct to vote when they have Has Previously Voted

previously voted. Black and red “no” icon displays.
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Voter Cannot Vote  Displays in OVRD mode when a voter presents
(right) themselves at a precinct to vote and they are in a Removed/Denied Voter
Removed or Denied status. Black and red “no” icon
displays.
Voter ID ID icon displays when the voter is flagged as Indicates that the voter must provide
(right) Validation needing to provide ID. Eﬁ
Proof of ID before voting. o
Voter Inactive Open book icon displays when a voter presents Indicates that the voter’s registration
(right) Voter themselves to vote after their status changed to information must be verified before
Inactive. 1
voting may occur. ~»
Voter Provisional  Provisional icon displays when a record was Indicates that the potential voter voted
(right) Voter logged as a provisional voter.
e 7
as a Provisional L < 4
Voter Election Populates with the current election information Displays the election date in
(right) Date after the Vote button is clicked. mm/dd/yyyy format.
Voter Voted Date Populates with the date that the voter presented  Displays the date voted in mm/dd/yyyy
(right) themselves to vote after the Vote button is format.
clicked.
Voter Ballot Style Populates with the Ballot Style assigned to the Displays the ballot style the voter
(right) voter after the Vote button is clicked. should have received.
Voter PCT/VTD Populates with the precinct and VTD information Displays the precinct and VTD related to
(right) linked to the address after the Vote button is the ballot cast.
clicked.
Voter Ballot ID Populates with the Ballot ID associated with the Displays the ballot id, which is made up
(right) voters’ record after the Vote button is clicked. of machine abbreviation and a unique
ballot number for that machine (e.g.
101-56).
Voter Action Populates when a voter has successfully cast a CANNOT VOTE HAS PREVIOUSLY
(right) ballot. VOTED
Voter Action Populates when a voter has successfully cancelled CANNOT VOTE HAS PREVIOUSLY
(right) their vote. VOTED
Voter Action Populates in OVRD mode when a voter has been CANNOT VOTE TRANSFERRED TO
(right) transferred to another voting location. [Precinct Name] PRECINCT
Voter Action Populates in OVRD mode when the user has CANNOT VOTE FLAGGED AS VOTED
(right) Flagged a voter has having an absentee record. ABSENTEE
Changes  Name Displays if a Name Change was made to the Displays Name Change From/To when a
Change selected registrant. name change is made
Changes  Address Displays if an Address Change was made to the Displays Address Change From/To
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Change selected registrant. when an address change is made

Changes PCT/VTD Displays if a Precinct/\VVTD Change was made to the  Displays PCT/VTD Change From/To if a
Change selected registrant. precinct change is made

SECTION 5: SEARCH PENDING APPLICATIONS

If a registrant cannot be found in the Registration List search, the ‘Pending Applications’ search can be used to
search the unprocessed registration records from VoterScan. Likely, the voter was missing some piece of
required information on their voter application that prevented him/her from becoming an Active voter. This
search is informational only and registrants cannot be voted in OVRD.

If the Search Pending option is not displayed in the search drop-down, it will need to be enabled in
File >Options by checking the “Allow users to search pending applications” checkbox.

To perform a search of pending applications, complete the following steps:

1. Click the ‘Search’ drop-down and select ‘Search Pending’.

2. Enter search criteria into the search fields. Check the ‘More Criteria’ box on the Home ribbon to
display the address search fields.

3. Click the ‘Search’ button or press Enter.

The results grid will display any matching records, as shown below.

o OVRDVoting (v.2.3.22) - LOCAL (one_stop) - EBurton - 11/08/2016 GENERAL
home | Toot
[C] More Criteria r @ as Abse 2 2 &j 4 @ =g i
AW 4 i . x : 2 3 %
[C] Show Removed Voters = : wi A v ©
Search  Clear o View New Voter s Print
- =g Pending Reg Prov Referral -
Search Voting Registration Provisional Voting
Search Criteria
Last Name ~ First Name Middle Name ~ DOB (MM/DD/YYYY) i
SMITH = =
Pending Applications (26 rows)
Name Address Party DOB Gender Race
(& SMITH. AMANDA JEAN 220 DOWNING ST TROUTMAN, NC 28166 03/03/1983

To view the information in the unprocessed registration record for a voter, select the record from the grid and
click ‘View Pending Reg’ on the

@ View Pending Application = .
Home ribbon. For example, the
ok e e B o Vet Verfication record below indicates that the
S Last Name First Name Middle Name Suffix NCDL . . ) . . . .
s S CanRETT R voter didn’t sign their application
Birth Date (mm/dd/yyyy) Birth State 55N .
i - and that is why they were not
Residence Address . i
House# Half  Dir Street Name l:l Type Suffix Unit Will you have lived here for 30 Days I‘eglstered
505 ABERDINESHIRE Cr or mare pricr to the Election Date?
City State ZIP Code Phone G Mave Date (mm/dd/yyyy)
HUBERT -] [ 28533 (&)
Mailing Address = = Vater Information
Address1 Is U.S. Address ’ Gender Application Dt Ballot Style I:l
MALE
Address2 Race Registration Dt NCID
WHITE o
Address3 Ethnicity Party Lt e
NOT HISPAN UNAFFILIATED
Address4 Status Reason
INCOMPLETE MISSING SIGNATURE Ansite H ‘
- - History
Previcus Name and/or Address Jurisdiction List
Last Name First Name Middie Name Suffix

Previous NC County (if applicable)

IsUS A 2
s U.S. Address e

Address1
404 TRADD ST
Address2

City i State ZIP Code
BEAUFORT NC 28516
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If the voter is found in the Pending Applications search, follow the county procedures.

NOTE: After completing the search for Pending Applications, be sure to click ‘Clear’ to return the
Search function to the default, or click the ‘Search’ drop-down and select Search Voters.
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CHAPTER 3: ELECTION DAY AND PROVISIONAL VOTING PROCESS

SECTION 1: OVERVIEW

The primary purpose of OVRD is to incorporate all the rules and manage the Election Day voting process
within a given county. This chapter will detail all phases of the voting process, including how to vote a
registrant, how to cancel a vote, and how to reprint an ATV form. OVRD also allows Provisional Voter
information to be entered, removing the need for the manual provisional process at One-Stop sites.

Election Day voting exists to allow registered voters to vote in-person at specific designated voting places.
The major distinguishing factor between one-stop voting and Election Day voting is that Election Day ballots
are not retrievable.

SECTION 2: HOW TO VOTE (OVRD)

In simplest terms, the voting process consists of three steps: searching for the registered voter, selecting the
correct voter, and clicking the Vote button. There are a lot of small variances that may be encountered along
the way such as id being required, addresses needing to be verified or even ballot party needing to be chosen
for primary elections. These will be addressed during the following listed steps of the process or in other
sections of this guide as noted.

1. Enter appropriate search criteria into the Search Criteria fields. This will typically be a name search
using the last name and first name (or first few characters of the first name with a wildcard). To
search address fields, click the ‘More Criteria’ check box on the Home ribbon. Alternatively, the
barcode search icon (to the right of the DOB field) can be clicked to scan a NC Driver’s License barcode
which will auto-populate most of the voter’s information.

2. Click the ‘Search’ button or press Enter.

e Ifthe voter is located, proceed to step 3.
e I[fthe voter is not located:
e Check spelling of name.
e Use wildcard option (%) to search for name.

o Verify that the voter has not changed their name since their last registration update.

i. Ifthereis a Name Change proceed with a voter update using the ‘Update Voter
Reg’ button. See Chapter 4, Section 2 for details on updating registrations.

ii. Ifthe voter is still not located, refer to county procedure to continue. Voter may
need to vote a Provisional ballot.

e Search Pending Applications (see Chapter 2, Section 5 for information on searching
Pending Applications). If the voter is still not located, refer to county procedure to
continue. Voter may need to vote a Provisional ballot.

3. Select a voter from the Potential Voters Grid. It is very important that the correct voter is selected. If
a voter is incorrectly selected and voted, that voter may no longer vote on this machine and they will
be forced to vote provisionally.

Warning: There may be several voters with the exact name. Always verify the correct voter is
selected by having the voter verify their:
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e Full Name
e Residential Address

Upon selection of a voter within the grid, the following actions are performed: buttons may be enabled
or disabled based on the allowed functionality and the voter information section is populated.

4. Check the voter’s vote status on the right side of the Voter Information Panel.

CANNOT VOTE
HAS PREVIDUSLY VOTED

Election Date: 12/24/2013

Voted Date: 12242013
Ballot Style: Do01
PCTNVTD: CLO7/CLO7
Ballot 1D D0o0-4
Appl. Num:

Magnified Voter Information Panel
If there is no vote data in the Voter Information Panel, proceed to Step 5.

b. Ifthere is vote data in the Voter Information Panel, this window indicates the voter has
already voted on the OVRD Machine or by an Absentee method, has been flagged as
Transferred or Absentee, or has been cancelled.

i. Ifthe voter is showing as VOTED but claims they did not vote already, proceed
with the Cancel Vote process set forth by the county board of elections. Cancel vote
is discussed in Section 3 of this Chapter.

ii. If the voter is showing VOTED and did actually vote already, this voter should not
be allowed to vote again.

5. Check the voter’s status on the left side of the Voter Information Panel.

WRN: 000000085350 ACTIVE CLOB/CLOB

DUCK, DONALD

J7TKNOLLDR
COLUMBUS. NC 28722

Magnified Voter Information Panel

If the registrant is eligible to vote, the Vote button will be enabled. If they are not eligible, the
reason will display on the right side of the Voter Information Panel.

a. Ifthe statusis ACTIVE or TEMPORARY, verify the registrant has a valid Ballot Style (e.g. G001) and
proceed to Step 6. If the voter has NO BALLOT as the Ballot choice, the voter has no contest for the
selected election and should not be allowed to vote.

b. Ifthe status is REMOVED or DENIED, they are not registered to vote in the election. The voter may
need to vote provisionally.
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c. Ifthe voteris INACTIVE, their registration must be updated using the ‘Update Voter Reg’ button.
This will update their status to ACTIVE and allow them to vote. Please review Chapter 4, Section 2
for instructions on making registration updates.

6. Verify the voter’s information.

a. IfNo voter information needs to be changed proceed to Step 7.

b. Ifany voter information needs to be updated, click the ‘Update Voter Reg’ button and make the
changes. See Chapter 4, Section 2 for instructions on making registration updates.

7. Click the ‘Vote’ button to process a vote for the selected registrant.

NOTE: Clicking the ‘Vote’ button drop-down will give the option to Vote In-Person or Vote Curbside (if
‘Allow Curbside Voting’ is checked in the options). Clicking ‘Vote without using the drop-down will use
the ‘Default Voting Method’ that was set in the options.

a. Ifthe voter is required to show HAVA ID before voting, the Proof of ID Required pop-up, as shown
to the below right, will appear. The type of ID the voter provides must be selected; the different
types are listed in the table below. Once a type has been selected, click the ‘Select’ button. Select
the ‘Cancel’ button if the screen has displayed unintentionally.

ID DOCUMENTS

Bank Statement

Government Check

NC Drivers License

NC Non-Operators ID

Other Government Document

Other Photo ID

Paycheck

Tribal Enrollment Card

U.S. Passport

US Military ID

Utility Bill

Veterans ID

If the voter does not provide the required ID, click

‘Cancel’ and proceed with the county defined process.

b. Ifthe voter’s party is registered Unaffiliated and the
election is a primary, the Party Required pop-up will
appear, as shown to the right. Select the Party of the
ballot indicated by the voter. Click the ‘Select’ button
to process the vote.

c. The Voting Method Required window will display.
Select a voting method from the list and click ‘Select’.

d. The ATV form and Transaction Record (if EPB: PRINT
OVRD TRANSACTION REPORT is set to ‘Y’) will print.

OVRD User Guide
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Proof of ID Required X

1D is required. Voter must provide ID from one of the options
listed below. Any option other than photo ID mustinclude
current name and address.

BANK STATEMENT
GOVERNMENT CHECK

NC DRIVERS LICENSE

NC NON-OPERATORS ID
OTHER GOVERNMENT DOCUMENT
OTHER PHOTOQID
PAYCHECK

TRIBAL ENROLLMENT CARD
U.S. PASSPORT

US MILITARY 1D

UTILITY BILL

VETERANS ID

‘ | Cancel

L3 |
Party Required |

Unaffiliated voters may choose a partisan or a non-partisan
ballot Selectthe voter's choice for ballot type.

DEMOCRATIC - D001
LIBERTARIAN - L0OO1
REPUBLICAN - R001
UNAFFILIATED - NO BALLOT

| Cancel 1-




If the incorrect voter was voted, search for the voter again and then proceed with the ‘Cancel Vote’
process (or the county defined process). See Section 3 for instructions on cancelling a vote.
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SECTION 3: CANCELLING A VOTE (OVRD)

The cancel vote functionality is available when a user votes for a registered voter incorrectly. Reasons for the
incorrect vote include, but are not limited to, selecting the wrong registered voter, choosing the wrong ballot
party for a primary, forgetting to update the residential address.

e In OVRD, once a vote is cancelled on a machine, another vote CANNOT be cast for that voter.
IT IS VERY IMPORTANT THAT THE CORRECT VOTER IS SELECTED WHEN VOTE IS CLICKED.

e The Cancel Vote permission is required to perform this task.

e The “Allow user to cancel Votes” option must be selected when the wizard is performed.

To cancel a vote for a registrant, perform the following steps:

1.

2
3.
4

Using the Search function, find the voter that has already voted.
Select the voter’s record in the Potential Voters grid to highlight it.
Click the ‘Cancel Vote’ button on the Home ribbon.

The Cancel Vote window will appear, as shown to the right. @® Cancel Vote hd
Use the ‘Reason’ drop-down arrow to select the appropriate Voter Reg Nurn: 000000079215

i . i Full Name: BROWN. LAURAL FAITH
reason for canceling the vote; the reasons are described below. Application Num: OS-TR12-000.5

Enter a Comment in the ‘Comments’ field as it is required. Election Date: 12/24/2013
: « ) Voting Date: 12/24/2013
Click the ‘Cancel Vote’ button once complete.

Available Reasons for Cancelling a Vote

Reason

Code Reason Description v

Description

CN CANCELLED  Use when election day worker needs to
cancel a “VOTE”.

NV NOT VOTED Use when ATV was issued, but voter

) Comments
chose not to vote at that time.
A% WRONG Use if it is determined that the election
VOTER day ballot was issued to a person other

than the voter.

Note: Any record with this reason will
NOT receive a contact.
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SECTION 4: REPRINTING AN ATV FORM (OVRD)

If a problem occurs during voting that prevents the ATV and Transaction Record forms from printing, the ATV
form can be reprinted using the ‘Reprint’ button.

To reprint the ATV form:

1. Using the Search function, find the voter that has already voted.
2. Select the voter’s record in the Potential Voters grid to highlight it.
3. Click the ‘Reprint’ button on the Home ribbon.

@ = OVRD Voting (v.2.2.12) - LOCAL (one_stop) - EBurton - 06/07,/2016 CONGRESSIONAL PRIMARY - Mach:S| 1RM108 - Site:ST3 = @ R

File Home Tools @

n ' O Mere Criteria ﬂ M Cancel Vote | 2 a Ea S & %

[0 Shew Removed Voters g Reprint

Search  Clear View New Voter  Existing  View R Print
& Voter Reg  Voter Prov Voter Prov  Pro Referral ~
Search Woting Registration Provisional Voting
Search Criteria
Last Name First Name Middle Name DOB (MM/DDIYYYY)
|BURTON | [DARREN [ | =]
Patential Volers (1 rows)

Name Address Mail Addr Ballot Siyle Party(Voled Parly)  Gender Race DOB

[d BURTON. DARREN DOUGLAS JR 1313 SCHOOL ST STATESVILLE. NC 28677 X BLACKOR 02/08/1965

SECTION 5: PRINTING A HELP REFERRAL FORM

A Help Referral Form is available if the check-in (registration table) official determines there is a need to refer
the voter to the Help Desk. To print the form, follow the steps below:

1. Click the ‘Print Referral’ button and choose ‘Print Blank’ to print a blank form or click ‘Print Selected
Record’ to print the form for the selected record.

e = OVRD Voting (v.2.2.12) - LOCAL (one_stop) - EBurton - 06/07/2016 CONGRESSIOMNAL PRIMARY - Mach:SBEWKD1RM108 - Site:5T3 E ik £
n Home Tools b
“ ' ] More Criteria S 2 ConcelVole . - ) a % S' $ il
| Show Removed Voters ad oy Reprint Transd " A s o E -
Search  Clear £ At Wiewr New Vater  Existing £ Print
ks Voter Prow Voter Prov | Referral » |
Search Veting Registraticn Provisional Veting
- - = Print Blank l
Search Criteria
Last Name First Name Middie Name DOB (MMDDNYYYY)
L T Pris dacted R
BURTON DARREN |- rint Selected Record
Potential Volers (1 rows)
Name Address Mail Addr Ballot Style Party(Voted Party) Gender Race DoB
[J BURTON, DARREN DOUGLAS JR 1313 SCHOOL ST STATESVILLE. NC 28677 x BLACKOR 02081965

On the referral form, the appropriate box will be blackened at the top to indicate One-Stop or Election
Day. The example on the next page is a form printed from OVRD.
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s 11/08/2016
.ﬁgﬁ%_@j Help Referral Form p——
[Vﬁ», IREDELL COUNTY, North Carolina

ek 08/25/2016

Wote Date

[l 0re-stop [ Election Day votingSite: IREDELL COUNTY BOARD OF ELECTIONS Worker _eburton

Voter's Information

MASON ANDREW GEDRGE DO0009836901
Last First BAicdle Suffix VRN

304 SAFRIET LOOP

Addreis

STATESVILLE NC 28625

City State Tip

Help Referral Reason

[ ] no Record of Registration [] Mo HAVA Acceptable ID

[ ] unreported Mave [] veter Assistance Meeded

|:| Incorrect Precinct |:| Wrong Voter Selected

|:| Previously Remowved
|:| Incorrect Party

|:| Unrecognized Address |:| Other:

HAVA Identification Provided by Voter (if applicable)

I:' MC Driver License D L5 Passport/Passport Card I:' L5 Veterans |0 Card I:l Tribal Enrollrment Card [Federal)

I:‘ MC Special ID Card |:| Out-of-5tate License/1D I:‘ U5 Military ID I:l Tribal Enrallrment Card [State)

[ ] other

Acknowledgment of Yoting Options
{Complata only if wober doss not want to be refermed to Help Saation or is choosing mot 1o cast & provisionad ballor )

1 ACKNOWLEDGE that the election officials at this site hawve notiied me of my voling
options, however | am choosing leave the voting site and'or not io cast @ provisional ballot at this fime due to the following reasons:

ter Shgriatars

OHLY Sutian | 116 | Dt T | BPIS/3006 10-PO-08 AM I Wi 0d
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SECTION 6: HOW TO VOTE (PROVISIONAL)

The Provisional voting process consists of four steps: searching for an existing or adding a new provisional
voter, entering registration information, entering provisional information, and Vote. ‘Existing Voter Prov’
allows you to create a Provisional record for an existing registrant. ‘New Voter Prov’ allows you to create a
Provisional record for an unregistered voter. There are a lot of small variances that may be encountered
along the way such as id being required, addresses needing to be verified, or even ballot party needing to be
chosen for primary elections. These will be addressed during the following listed steps of the process or in
other sections of this guide as noted.

1.

Enter appropriate search criteria into the Search Criteria fields. This will typically be a name search
using the last name and first name (or first few characters of the first name with a wildcard). To
search address fields, click the ‘More Criteria’ check box on the Home ribbon. Alternatively, the
barcode icon (to the right of the DOB field) can be clicked to scan a NC Driver’s License barcode which
will auto-populate most of the voter’s information.

Click the ‘Search’ button.

If the voter is located, select their record from the results grid and click ‘Existing Voter Prov’ from the
Provisional Voting section of the ribbon. If the voter is not located, click ‘New Voter Prov’.

m Home Tools
S S e
I\ T e i e ok E 3 2o = r ) =
ﬂ , [ More Criteria a-’ ;f Cancel Vote = = . 5 5 g .
[ Show Removed Voters e w5 Reprint la g 3 E
% - v N Ze iy Ly
Search  Clear C = View ew Voter  Existing Print
= ter R Voter Vioter Pro Referral
Search Voting Registration visional Voting

The Provisional Data Entry (registration information) screen will display. If ‘Existing Voter Prov’ was
clicked, any data from the current voter’s record will be pre-populated in the appropriate fields, as
shown below.

@ Provisional (Existing) Data Entry = |8 2
Application Information Name
Last Name First Name Middle Narme Suffix
i‘s C'“Z:” @ HARRISON [BETTY [s [
' Birth Date (mm/dd/yyyy) Birth State
071/27/1941 [=] [nc [+
Residence Address
House# Half  Dir Street Name Type Suffix Unit Will you have lived here for 30 Days E‘
108 |v ROBIN ‘v LN |v ‘v or more prior to the Election Date?
City State  ZIP Code County Phone @ yag Move Date (mm/dd/yyyy)
STATESVILLE [=[nc || z677 |+ |~ © No
Mailing Address o Voter Information
e 7 IsUS Address? Gender b oy
FEMALE  [»| [ NOTHISPANIC|=
Address2 Race Party )
WHTE  [r] |[DEMOCRATIC [+]
City State ZIP Code NCDL #

SSN (Last 4)

Previous Name and/or Address
Last Name First Name Middle Name Suffix

Previous NC County (if applicable)

[+

[¥] Is U.S. Address?

Address1
Address2

City State ZIP Code

Acknw Cancel

‘ pleadt ‘ ‘ Only ‘ ‘ el Vate
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If ‘New Voter Prov’ was clicked the screen will be blank (as shown in the image below).

@ Provisional (New) Data Entry o|B

Application Information Name
Last Name First Name Middle Name Suffix
U.S. Citizen

 Yes © No
e N Birth Date (mm/dd/yyyy) Birth State
Residence Address

House# Half  Dir Street Name Type Suffix Unit Will you have lived hers for 30 Days E

[ [+ |~ [~ ar more prior to the Election Date?

City State ZIP Code County Phone & Yes Mave Date (mm/dd/yyyy)
Cl.E E - - o
Mailing Address - Voter Information
Address 1 418U Address? g | Gender Ethricity
Address2 Race Party
City State ZIP Code NCDL #
SSN (Last 4)
Previous Name and/or Address
Last Name First Name Middle Name Suffix

Previous NC County (if applicable)

v Is U.S. Address?

Address1
Address2

City State ZIP Code

Acknw
Only

Cancel

—— [x S

4

5. Fill in appropriate registration data or scan an NCDL barcode to automatically populate voter data.
Fields with names in red text are required and must be populated to move to the next step. When all
data has been entered, click ‘Next'.

2 If the voter does not want to vote provisionally, click the ‘Acknw Only’ button to print an
'56 Acknowledgment Notice which informs the voter of their options to vote and must be signed
by the voter. Clicking “Acknw Only’ prints the form and cancels the Provisional vote process.

This data will be transferred to One Stop System Manager with the rest of the SOSA
vote/update/provisional data and can be found under Tools=>Acknowledgment of Voting
Options.

To check the status of a NC Driver’s License, click the small barcode icon to the right of the US

Citizen checkbox and scan the NCDL with a 2D scanner to determine if the ID is expired or not
expired. If a match is found, it will also populate the voter data on the screen. See Section 8 for
more information on scanning NCDLs.

6. The Proof of ID Required pop-up, as shown on the next page, will appear. The type of ID the voter
provides must be selected; the different types are listed in the table on the next page. Once a type has
been selected, click the ‘Select’ button. If the Provisional voter does not provide ID, click the ‘No ID’
button. Select the ‘Cancel’ button if the screen has displayed unintentionally.
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-
@ Proof of ID Required =

This voter is registered and has been flagged as needingto ID DOCUMENTS

show a form of ID as a firsttime reqgistrant, or this voter is not Bank S

registered and may potentially need to show a form of ID as ® an tatement

afirsttime registrant. Please ask the voterto present one of G t Check

the forms of ID listed below. fthe voter does notpresentID, O overnmen ec

the vot till vot isionally by selecting the "No ID" s s

bfﬂZﬁ Erell'gs:f still vote provisionally by selecting the "No . NC Drivers License
BANICETATEMENT = e NC Non-Operators ID
GOVERNME NT.CHECK e  Other Government Document
NC DRIVERS LICENSE

NC NON-OPERATORS ID e Other Photo ID

OTHER GOVERNMENT DOCUMENT o P heck

OTHER PHOTO ID aycnec

RAXGHECK e Tribal Enrollment Card
TRIBAL ENROLLMENT CARD

US PASSPORT e U.S.Passport

US MILITARY ID = s

U BILL e US Military ID

VETERANS ID I ° Utility Bill

[ N | [ Concat | e Veterans ID

If the voter does not provide the required ID, click ‘No ID’ and proceed with the provisional process.

7. Based on the voter’s address and party information entered on the Provisional Data Entry screen, a
default ‘Party Voted’ and ‘Ballot Style Ballot Style Validation Warning P

Issued’ will be set. If the voter’s

registered party is Unafﬁliated and the Mo Ballot Styles found for the selected Party Voted. Please select a Party
election is a primary’ the message % Voted which has an available Ballot Style.

shown to the right may display (if there

are no UNA contests). Click OK and ok
select the appropriate ‘Party Voted’

from the drop-down on the Provisional

Information screen. Select the appropriate ‘Ballot Style Issued’ from the drop-down (see example on
next page).

The ‘Ballot Style Issued’ field will be blank if there is not a matching ballot style for the address (likely
due to a Geocode issue).

$|

8. The Provisional Data Entry (provisional information) screen will display as shown on the next page.
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@ Provisicnal (Existing) Data Entry

Provisional Voter Registration Information

Provisional Voting Reason

Full Name

US Citizen?

Birth Cate

Age

VRN

Residential Address

Residential County

BETTY S HARRISON
Yes

01/27/1941

76

000003721600

108 ROBINLN
STATESVILLE NC 28677

[[] Curbside

Party Voted Default Ballot Style
(N0 BALLOT

EBallot Style Issued Assigned Precinct
L 5T6

Reascnable Impediment ¢ ves & [

Reasonable Impediment Reason

Will you have lived Yes
here for 30 days or |
maore prior to the :
Election Date? _Reasonﬁble Im_pedlmem. Comments
Move Date
Phone
Mailing Address Jurisdiction List
: pCT STE STATESVILIE £6
Previous Name cone 12 CONGEESSIONAL DISTRICT 13
Previous Address SUPCT 2zR 22 SUPERIOR COURT
Previous County i i 2R InIC L
NCSEN 44 NC SEWATE DISTRICT 44
Birth State NC NCHSE 035 NC HOUSE DISTRICT 35
NCDL TWE ST STATESVILLE
asN EIED 4 SCHOOL #4
PROS 2z 22R PROSECUTORIAL
Gender FEMALE v 5T sTe
Race WHITE
Ethnicity NOT HISPANIC or NOT LATINO
Party DEMOCRATIC
1D Provided? NC DRIVERS LICENSE
: : Acknw Cancel
‘ Previous ‘ ‘ Review ‘ ‘ Only ‘ ‘ *x Vote

Select a Provisional Voting Reason from the drop-down and the Ballot Style Issued (if not already

populated)

If the provisional vote was cast curbside, check the ‘Curbside’ box

If the voter does not want to vote provisionally, click the ‘Acknw Only’ button to print an

Acknowledgment Notice which informs the voter of their options to vote and must be signed by the
voter. Clicking ‘Acknw Only’ prints the form and cancels the Provisional vote process.

Click ‘Review’ once all required fields are populated. The Provisional Voting Application form/label

will print to the default printer. If ‘Reasonable Impediment’ was set to ‘Yes’, the Reasonable
Impediment Declaration form will also print.

OVRD User Guide
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9. The Provisional Data Entry (review) screen will display as shown below.

OVRD User Guide

@ Provisional (Existing) Data Entry = |58 £

Provisional Voter Registration Information Provisional Voting Information

Full Name BETTY S HARRISON Election Date 07/11/2017 i
US Citizen? Yes Poll Book Number SH-B-B01-1

Birth Date 01/27/1941 PIN CG68-B01-1

Age 76 Location Voted SHB

VRN 000003721600 Assigned Precinct STATESVILLE #6 L
Residential Address 108 ROBIN LN Provisional Vioting JURISDICTION

STATESVILLE NC 23677 Reason DISPUTE

Residential County Reasonable Impediment  No

Will you have lived Yes Reasonable Impediment

here for 30 days or Reasons

more prior to the =y Lot - fol
Election Date?

Move Date

Phone

Mailing Address Jurisdiction List

: BCT sTE STRTESVILIE £&

Previous Name cone 13 CONGRESSICWAL DISTRICT 13
Previous Address SUBCT 223 223 SUPERIOR COURT

Previous County L ESh e

NCSEN a4 NC SENATE DISTRICT 44

Birth State NC NCHSE EEH NC HOUSE DISTRICT 355

NCDL TWE st STATESVILIE

25N BIED 4 SCHOOL %4

DROS 223 271 DROSECUTORIAL

Gender FEMALE wTD sTE =TE

Race WHITE

Ethnicity NOT HISPANIC or NOT LATINO

Party DEMOCRATIC

1D Provided? NC DRIVERS LICENSE

: Acknw Cancel
| Previous | ‘ & Vate ‘ Only ‘ ‘ x Vote
A

a. To cancel the Provisional process on the selected voter, click the ‘Cancel Vote’ button.

b. Ifthe voter does not want to vote provisionally, click the ‘Acknw Only’ button to print an
Acknowledgment Notice which informs the voter of their options to vote and must be signed
by the voter. Clicking “Acknw Only’ prints the form and cancels the Provisional vote process.

Once ‘Vote’ has been clicked, a Provisional vote cannot be cancelled afterward. The ‘Note’
function is also disabled for Provisional records.

c. Ifeverything is correct, click ‘Vote’ to complete the Provisional process. The Provisional Voter
Instruction sheet (or label depending on the print settings) will print.
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SECTION 7: REPRINTING A PROVISIONAL FORM

If a problem occurs during the voting that prevents the Provisional Forms/Labels from printing, the
application can be reprinted using the ‘Reprint’ button in the Provisional Voting section of the Home ribbon.

To reprint the Provisional form/label:

1. Using the Search function, find the voter that has already voted.

2. Select the voter’s record in the Potential Voters grid to highlight it.

3. Click the arrow under the ‘Reprint’ button in the Provisional Voting section of the ribbon. Choose

‘Reprint Provisional Form’ or ‘Reprint Instruction Sheet’.

D - OVRD Viting (v.2.2.12) - LOCAL (one_stop) - EBurton - 06/07/2016 CONGRESSIONAL PRIMARY - Mach:SBEWKO1RM108 - Site:5T3

Tools

n ' [ More Criteria & ™ Canc Ste lag as Absentee ":‘ ":"
[ Show Removed Voters T #p Reprir -lag as Trans BA BA
Search  Clear e ) o

-

Search Voting Registration

E -y F

&B |/ 4 \’E’ % ¢
New Voter  Existing View  Reprint int

Prov ote Prov = Referral -

Provisional Voting

SECTION 8: 2D BARCODE SCANNING FOR DRIVER’S LICENSE VALIDATION AND VOTER

DATA POPULATION

OVRD now offers the ability to scan a North Carolina driver’s license to verify that the license is valid and to

automatically populate voter data on the Search or Data Entry screens.

2D Barcode scanning can be accessed from the following screens by clicking

Application Information

the small barcode icon that appears near the US Citizen check box: Update (] US Citizen m
Voter Reg, Issue Vote, New Voter Prov and Existing Voter Prov.
There is also a Barcode Search icon on the main screen (to the right of the
DOB field) to populate search criteria (see page 33). DOB (MM/DD/YYYY) m
1. To verify a license, click the Barcode -@ P %

icon. The pop-up to the right displays.

2. C(lick in the NCDL Barcode textbox to
set the cursor focus to the textbox.
Using a 2D barcode scanner, scan the
barcode on the back of a North
Carolina driver’s license.

OVRD User Guide

Scan the NC DMV licensefID card barcode to check the expiration and
populate the data entry fields.

NCDL Barcode

|

Cancel
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3. The NCDL Barcode field will populate @ Scan NCDL Barcode o=
with the information scanned from the

barcode. Scan the NC DMV licensefID card barcode to check the expiration and
PPN . late the data entry fields.
4. Click ‘OK’ to determine whether or not the S
license is valid and populate the data _NGDL i
entry fields. One of the messages below e | 2
ill di i | AAMVA3ED04001 DLO0280193DLDABSMITH =
will display with NOT EXPIRED or nlyaiebliaopeny
EXPIRED. DAD
DAE

DAL304 MACON DR

5[ G |

MCDL Scan Vertfication Information £

MCDL Venfication Results: MOT EXPIRED

oK ] License expiration date has not been reached and is valid.

MCDL Scan Verification Information P

License expiration date has been reached and is no longer

0K valid.

_ MCDL Scan Verification Information P
MCDL Scan Verification Information 8

B ‘:] MNCDL Verification Results: EXPIRED — 4 YEAR EXCEPTION
) MCDL Verification Results: EXPIRED - 70 YEAR OLD EXCEPTIOM 4

o | x|

License is still considered valid as it meets the 70 year old exception or the 4-year exception.

o I[fthe license expired after the voter’s 70t birthday, it meets the 70-year old exception
o [fthe license has been expired for 4 years or less, it meets the 4-year exception
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1. To Search for a voter from an NCDL click

the Barcode Search icon on the main & Scan NCDL Barcede
screen. The pop-up to the right displays.
2. Clickin the NCDL Barcode textbox to set Scan the NC DMV licensefID barcode to search for a voter.

the cursor focus to the textbox. Using a
2D barcode scanner, scan the barcode on
the back of a North Carolina driver’s
license.

3. The NCDL Barcode field will populate
with the information scanned from the
barcode.

4. Click ‘OK’ to search for the voter. If a

NCDL Barcode

match is found, the record will display in ok || Ccancel

the Potential Voters grid.
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CHAPTER 4: REGISTRATION UPDATES

SECTION 1: OVERVIEW

During Election Day voting, a registered voter may update their name, address, or phone number information
so long as the residential address change is within the same county. The registration update function of the
OVRD application allows users to update current voter information using the ‘Update Voter Reg’ button. This

process must be performed on INACTIVE voters.

SECTION 2: UPDATING AN EXISTING REGISTRATION

Use the following procedures to update voter registration information for Active and Inactive voters. The
voter must have lived at the new address for 30 days or more prior to the Election Date to make the update in

OVRD.

The following procedure demonstrates how to update a voter’s registration information for Active and

Inactive voters.

1. Using the Search function, find the voter that wants to update their information.

2. Select the voter’s record in the Potential Voters grid to highlight it.
3. Click the ‘Update Voter Reg’ button.

@ Update Voter Registration

The Update Voter

. . Step 1 of 2: Please enter the registration information and click ™ Review.™
Reglstratlon screen

Application Information Name

will display with Step 1 i | | Fis ome Mdde toms
of 2. Birth Date (mm/dd/yyyy) Birth State

NC
Residence Address

Use this screen to
. . House# Half  Dir
make any registration [ =] [cHevene EREEE

City State ZIP Code Phone

Street Name Type Suffix

Unit

Changes allowed. JACKSONVILLE [=] [nc |=] [2es20  [+] [252-2082182
Mailing Address 7 1s U.S. Add 9@ Voter Information
Address1 s ress Gender Application Dt Ballot Style
To check the status of a o po ol iy
NC Driver’s License Ak Race Reqgistration Dt NCID
WHITE DD115204
and/or popu]ate the City State  ZIP Code Ethnicity Party

|v |v ‘v NOT HISPAN UNAFFILIATED

voter data, click the
small barcode icon to
Previous Name and/or Address

Religious Objecter

Voter Verification
NCDL

SSN

Will you have lived here for 30 Days E
or more prior to the Election Date?

Move Date (mm/ddfyyyy)

Vote
Provisional

Print Referral

Absentee
History

‘ ‘ Comments

Jurisdiction List

the right of the US Lest Name First Name
Citizen checkbox and i s
scan the NCDL with a e
2D scanner to e
determine if the ID is

Middle Name Suffix

Previous NC County (if applicable)

WND4

brvd
W3
03
048
04
06
015
04

WNO4

JACKSONVILLE

TW3

CONGRESSIONAL DISTR..
4B SUPERIOR COURT
4TE JUDICIAL

NC SENATE DISTRICT &
NC HOUSE DISTRICT 15 |
4TE PFROSECUTORIAL -

|

City State ZIP Code

expired or not expired.

| Review

s Cancel
X Vate

The Data Entry fields

will be populated with the voter data if the NCDL is found. See Section 8 for more information on

scanning NCDLs.

If the voter needs to vote Provisionally, the ‘Vote Provisional’ button will exit the Update Voter
process and launch the Provisional Data Entry process. See Chapter 3, Section 6 for details on the

provisional voting process in OVRD.

OVRD User Guide
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If the voter has an issue that requires sending him to the Help Desk, click the ‘Print Referral’ button to
print a Help Referral Form which the voter will take with them to the Help Desk.

The ‘Absentee History’ button will display any Absentee information for the current election. The
‘View Street Ranges’ button will show the Geocode information for the ‘Street Name’ entered. Use the
‘Comments’ button if there is a need to add a comment regarding the registration changes being made.
‘Cancel Vote’ will cancel the vote process and return you to the search screen. To clear the existing
Residence or Mailing address information, click the red eraser icons at the end of each address
section.

If the voter has a religious objection to being photographed and has informed the county BOE of this,
the Religious Objector box will display with a checkmark to inform the One-Stop Worker that photo ID
will not be provided by the voter. Note: Religious Objector functionality remains, but the ID law has
been repealed, making this now irrelevant.

Enter all available registration information.

4. Click the ‘Review’ " @ updote Ve giatin 5
button to Complete lsel;gﬁ:{ii:nIi:‘r:;e:r?:;g:i"e:lst:t:ri:;;fr;n::‘iduc;;‘tered and click "Back"” if changes are needed. Othemwise, click "Vote" to save the voter
Step 1 and move to e ITJaﬂsTrjamn First Name Middle Name Suffix xgtg\[VEﬂfICﬂt\Oﬂ
Step 2. The screen [ [err &5
. Birth Date (mm/dd/yyyy) Birth State SSN
will change to Step 2, He
1 Resid Add
as Shown to the rlght’ H:?;E?CEHEHESEDW Street Name I:l Type Suffix Unit Will you have lived here for 30 Days |Z|
Wlth all fleldS 1734 10TH AV | DR NE or more prior to the Election Date?
City State ZIP Code Phone r Move Date (mm/ddfyyyy)
Chang]ng tO read- HICKORY NC 28601 | 999-999-9998 | i
only, allowing the e e e
user to review the MALE 5 [-] [nooamooarooanoos Erviio]
. . Address2 Race Registration Dt NCID
information. There e | [aviroszes
Hi
are several pop-up = BT - [ —
screens that may
appear at thlS Stage Previous Name and/or Address Jurisdiction List
as Well They are Last Name First Name: Middle Name Suffix = T o =
i Previous NC County (if applicable} :Amsi ;aa iizzi: WARD 3
listed below.
CONG 0s CONGRESSIONAL DISTR.
Address1 SUBPCT 25B 25B SUPERIOR
JUD 25 25TH JUDICIAL |
Adress? = B e
City State ZIP Code - - =
| Back |<¢ Vote |x Concs
: : 53
° If an error pop_up screen appears, Update Voter Registration Error
as shown to the right, then the g
residential address entered is The address entered cannot be found in the county’s geocode listing.
invalid due to it not being a valid - Detail=>

Geocoded address for the county.

The user can either fix the address (if a mistake was made during data entry) or have the voter
vote a Provisional ballot

(fOllOW the county Update Voter Registration Error

procedures)- o Cannot continue the vote process!

: : : The voter registration record as entered contains an address that is not valid for this
* If a residential address is election and therefore is not eligible to receive a ballot.

valid but there is not a Detail>>

t H
&3
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valid ballot style related to that address (and voter’s age) for the election, the user will receive the
message shown to the right. The user can either fix the address (if a mistake was made during
data entry) or have the voter vote a Provisional ballot (follow the county procedures).

e I[fthe election is a Primary
election and the registrant
being updated has a ballot
party with no valid ballot

L v e

e e ) e | ) el o

TPy

Staal

Update Voter Registration Error

style associated with it, the

user will receive the

message to the right. The voter may have to vote a Provisional ballot (follow the county

procedures).

e Ifthe voter’s new address is not in the OVRD
precinct the message to the right will appear.
Clicking ‘Yes’ will process the transfer, clicking

Cannot continue the vote process!

The voter registration record as entered contains a party that is not valid for this
election and therefore is not eligible to receive a ballot.

28
ok |
Detail=>

Ok

‘No’ will cancel the transfer.

5. Verify that any changes made are correct, or that

additional changes are not needed.

If the changes are correct, proceed to Step 6.

If the changes
are incorrect,
or additional
changes are
needed, click
the ‘Back’
button to edit
the
registration
information.

6. Click the ‘Vote’ button
in order to casta
ballot related to the
changes just made.
Select the ‘Voting
Method’ when the
Voting Method
Required pop-up
displays.

At this point, OVRD

@ Update Voter Registration

Update Voter Registration Question

.e.

The registered voter is not eligible to vote at this machine's election
site. Only a transfer may be performed.
Do you wish te continue processing the transfer?

Mo

Step2of 2: Pleasereviewthe information entered and click "Back” if changes are needed. Othemise. click "Voie" to save the voter

registration information as a transfer and vote.

Application Information

Name

Vaoter Verification

- Last Name First Name Middle Name Suffix MNCDL
US Citizen =
WILSON MARY DUNN
Birth Date (mm/dd/yyyy) Birth State SSN
NC =
Residence Address
House# Half  Dir Strest Nama |:| Type Suffix  Unit Will you have lived here for 30 Days
3001 E WINDGATE CT ormare prior to the Election Date?
City State ZIP Code Phene ol Move Date (mm/dd/yyyy)
JACKSOMVILLE NC 28546 252-299-2182 £
Mailing Address —— = Vater Information
Address1 sUs ﬁd:hess.r Gender Application Dt Ballot Style P plote 1
FEMALE s002 fevisiona
Address2 Race Registration Dt NCID
WHITE DD115204 i
13
City State ZIP Code Ethnicity Party Ak
NOT HISPAN UNAFFILIATED Religious Objectar
Absentee s
History
Previous Name andfor Address Jurisdiction List
Last Name First Name Middle Name Suffix T mo3 ENO3 =
MUNT X JACKSONVILLE 1
e o Previous NC County (if applicable) WERD iz Wz
i CONG 03 CONGRESSIONAL DISTR..
Address1 SURCT 048 4B SUPERIOR COURT
JuD 04 4TH JUDICIAL
NESEN 08 NC SENATE DISTRICT &
Address2 NCESE 014 NC HOUSE DISTRICT 14 |
PROS 04 4TH PROSECUTORIAL -
City State ZIP Code
‘ Back | < Vote X C\?,gf:‘

will determine if the voter must provide ID and/or select a party ballot (similar to Step 7 of Chapter 3,
Section 2). Once this is determined and provided, if necessary, the ATV form and Transaction Record
(if EPB: PRINT OVRD TRANSACTION REPORT is set to ‘Y’) will print. Once printed, the voter should be
directed to review the information on the form and sign it, and follow their county procedures.

OVRD User Guide

After the Vote occurs and the Transfer to BOE is completed at the end of the Election Day, the record
will be sent to VoterScan for verification of these changes.
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SECTION 3: ELECTION DAY TRANSFERS

With OVRD'’s Election Day Transfer function, the user will be able to record a transfer, print out an ATV form
with the transfer section filled out, and vote the person. In addition, the user will have the ability to mark a
person as “voted” if another polling place calls and states that a voter had voted at their polling place.
Transfers are only allowed if the option was set during the Wizard to allow them.

For the case where a voter is registered in the OVRD precinct, but has moved and now resides in another

precinct, follow these steps:

1. Search for and select the
registrant in OVRD. Click on the
‘Update Voter Reg’ button. When
the screen to the right displays,
update the address with the
registrant’s new information.
When complete, click the ‘Review’
button.

continue or ‘No’ to cancel:

change to a ‘“Transfer’ button.

Click the ‘Transfer’ button to print
the Election Day Transfer form and
log the registrant as transferred.
Then send the voter to the correct
precinct with their Transfer form.
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Once the ‘Review’ button is clicked, the
message to the right will display. Click ‘Yes’ to

When ‘Yes’ is clicked, all the fields on the screen
will be disabled and the ‘Review’ button will

@B Update Voter Registration

Step 1 of 2: Please enter the registration information and click ® Review."
Application Information Name Voter Verification
e Last Name First Name: Middle Name Suffix NCDL
fizen @ WILSON ANTONYO DAMANIQUE -
Birth Date (mmjdd/yyyy) Birth State SSN
Residence Address
House# Half  Dir Street Name Type Suffix Unit Will you have lived here for 30 Days |Z|
402 || [scorr - [aE |- ¥ [310 or more prior to the Election Date?
City State ZIP Code Phone @ Mave Date (mm/dd/yyyy}
JACKSONVILLE [«] [nc [+] [28546 |+ [910-382-9088 €
Mailing Address o Voter Information
Address1 ¥ 1sUS AddressT gp]  Gonder Application Dt Ballat Style ey
MALE 002 Ove e
Address? Race Registration Dt NCID
BLACKOR A/ DD123463 e
rint Referral
City State ZIP Code Ethnicity Party -
|~ I3 |~ UNDESIGNA UNAFFILIATED Religious Objectar
Absentee H o ‘
History
Previous Name andjor Address Jurisdiction List
Last Name First Name Middle Name Suffix = —— T ]
MUNI X JACKSONVILLE
e o Previous NC County (if applicable) WARD Tz Wz
1 U.S. Address? cone 03 CONGRESSIONAL DISTR.
| Bl suecT 018 4B SUPERIOR GOURT
JUD 04 4TE JUDICIAL
NCSEN 06 NC SENATE DISTRICT &
Address2 NCHSE 014 NC HOUSE DISTRICT 14 |
PROS 04 4TE PROSECUTORIAL -
City State ZIP Code o
T ancel

Update Voter Registration Question

Do you wish to continue processing

@' site. Only a transfer may be performed.

the transfer?

Mo

D Update Voter Regictration
Step2of 2: Ph

tronster,

Application Information

d and click *Back" if changes are needed. Otherwise. chick "Trmnsfer” o prnt the

Voter Venfication
NCDL

First Name Middio Nanwo Suffx
B [waLSON ANTONYD DAMANIGUE
Birth Dete {mm/ddiyyyy) Bath State SN
Residence Address :
Howe® Hel  Dif et Ny Type Suffox Urst Wl you hawe lived hese for 30 Days
&0 ME eil o mare prior ta the Election Date?
City Stole 2P Cod Phons Move Date (mmiddiyyyy)
JBCKSOMILLE [ 546 SI0-252-9066
Mailing Address X . Vioter Infoemation
Address1 UG- AddentT) o | Application Dt Bafiot Styls e
MALE -| [soe1 L
Address? Race Reqgsiration Dt HCID
BLACK OR & -| |Donzses R
1 Faofural
City Sate  TIF Code Ethricity Party it )
UNDESIGNAT URAFFILIATED
Absonton
Hiatory Comments
Previous Name and/or Address Junsdhctson Lest
Last Name First Marne Wi Name: Sl o s - =
nx
Previous NC County {il epphcoble) 4
= o
| Address1 48
o
o
Addressd %
o
City Stale ZIP Code




For the case where a voter was registered in another precinct but has moved to the OVRD machine’s current
precinct, follow these steps:

1. Search for and select the registrant in OVRD (the lower left box should display “Cannot Vote Not in
Precinct”). Click on the ‘Update Voter Reg’ button. When the Update Voter Registration window
appears, update the address with the registrant’s new information. When complete, click the ‘Review’
button.

2. Ifeverything is correct, click the ‘Vote’ button to save the changes as a transfer and vote.
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SECTION 4: VIEW REGISTRATION AND PROVISIONAL INFORMATION

To view more detailed registration information for a selected voter, such as Status, Status Reason,

Jurisdictions, or DL/SSN,
use the ‘View Voter Reg’
button on the Home ribbon.
The View Registration
window will appear.

To view the information for
a selected Provisional voter,
use the ‘View Prov’ button
on the Home ribbon in the
Provisional Voting section.
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@ View Voter Registration

Application Information Name Voter Verification
US Citi Last Name First Name Middle Name Suffix NCDL
s WILSON ANTONYO DAMANIQUE ] |
Birth Date (mm/dd/yyyy) Birth State SSN
Residence Address
House# Half  Dir Street Name I:l Type Suffix Unit Will you have lived here for 30 Days
402 | | SCOTT AVE 310 armore prior to the Election Date?
City State ZIPCode  Phone o Move Date (mm/ddfyyyy)
JACKSONVILLE NC 28b48 910-332-9066 (]
Mailing Address = = Voter Information
Addressi Is U.5. Address? Gender Application Dt Ballct Style
| MALE [ 5 [~] [soo1
Address2 Race i Regqistration Dt NCID
BLACKOR Af |-] |DD123463
City State  ZIPCode Ethnicity ) Party )
[=] | [+ UNDESIGNAT ~| | UNAFFILIATED|~ Religious Objector
Status Reasan e
ACTIVE | vErIFiED | Siee H
History
Previous Name and/or Address Junsdiction List
Last Name First Name: Middle Name Suffix Y= =08 EMOE ]
MUNT mx JACKSONVILLE
L Previous NC County (if applicable) WARD JHa JHe
SRS cane 03 CONGRESSICNAL DISTR..
Address1 suRCT 04E 4B SUPERIOR COURT
Jun 04 4TH JUDICIAL
NCSEN 06 NC SENATE DISTRICT &
Address2 WCESE 012 NC HOUSE DISTRICT 14 |
BROS 04 4TH PROSECUTORIAL -
City State ZIP Code
& view Provisional In O

Provisional Voter Registration Information

Provisional Voting Information

Full Name ALLISON MARIE MASON Election Date 07/11/2017 =
US Citizen? Yes Poll Book Number WMB-100-2
Birth Date 06/01/1998 PIN CGEB8-100-2
Age 19 Location Voted WMB
VRN 000009849765 Assigned Precinct CODDLE CREEK #2
Residential Address 1580 DOGWOOD LN Provisional Voting UNREPORTED MOVE
STATESVILLE NC 28625 Reasan
Residential County IREDELL COUNTY Reasonable Impediment  No
Will you have lived Yes Reasonable Impediment
here for 30 days or Reasons
more prior to the = il | i ud
Election Date?
Move Date
Phone
Mailing Address Jurisdiction List
pcT STE STATESVILLE #6
Previous Name MUNT STI CITY OF STATESVILLE
Previous Address WARD STIé STATESVILLE WARD#&
Previous County coNG 13 CONCRESSIONAL DISTRICT 13
SUPCT 22a 22Za SUPERIOR COURT
Birth State MA JUD 222 273 JUDICIAL
MNCDL NCSEN 44 HC SENATE DISTRICT 44
38N HCHSE 085 NC HOUSE DISTRICT 35
TWE ST STATESVILLE
Gender FEMALE BDED 4 SCHOOL £4
Race WHITE PROS 223 2ZA PROSECUTORIAL
Ethnicity NOT HISPANIC or NOT LATING v e 28
Party UNAFFILIATED
ID Provided? NC DRIVERS LICENSE
o] o] [ e
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CHAPTER 5: DATA TRANSFERS

SECTION 1: OVERVIEW

This chapter outlines the process for closing down an OVRD machine at the end of the Election Day. This
process must be completed on each OVRD machine used during Election Day.

SECTION 2: TRANSFER DATA FROM THE COUNTY BOE

Below are the steps to transfer data from the file exported at the county to the OVRD machine. Itis important
to perform this task BEFORE voting starts on Election Day to ensure you have the most recent registration
data in your local database. The user will take the export file located on the portable media device, such as a
USB drive, back out to the OVRD site and import it into the machine using the steps below.

1. From the Tools tab in OVRD in LOCAL mode, click the
‘Transfer’ button. N

2. The Data Transfer screen will appear, as shown to the
right. Verify the ‘From BOE’ radio button is selected.
Click the ‘Browse’ button to select the location of the
portable media device, if needed. Once the database file
location is selected, click the ‘Run’ button to start the
import of the export file.

3. The screen below will display, indicating that the import
process has begun.

Data Transfer (From BOE) Process Status

Please wait while job completes ___

Job Name: Decrypt Started At: 12/5/2013 12:46 PM

Job Name: Decrypt Completed At: 12/5/2013 12:46 PM

Job Name: Decompress Started At 12/5/2013 12:46 PM
Job Name: Decompress Completed At 12/5/2013 12:46 PM
Job Name: Load Database Started At 12/5/2013 12:46 PM

4. Upon completion, a Load Database screen will appear, as shown to the
right, indicating the import is complete. The portable media device can

now be removed and used on a different machine if needed.

OVRD User Guide

@ Data Transfer = B %

Data Transfer Method

* From BOE

" To BOE (New)

R i
Description
Imports a file that was generated from SOSA System Manager by replacing all the
lookup table data in the local database on this machine with the data in the file
Location
File Name
Q8VDEBEnc.ezp

Status

Load Database

:] Database is loaded.

.
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SECTION 3: TRANSFER DATA TO THE COUNTY BOE

The process of transferring data back to the county is done at the end of the Election Day when the polls are
closed. The transfer of data back to the county database can only be done once, which then disables the
machine for further OVRD voting use. Therefore, it is important not to perform a ‘Transfer to BOE’ until the
polls are closed. A warning message will display when the ‘Transfer to BOE’ tool is selected that this process
can only be done once. The data (registration updates, votes and provisionals) is transferred back to the
county database during this process.

IMPORTANT!
Once the transfer has been run on an OVRD machine, voting will no longer be permitted.

Before continuing, be sure to have the USB drive plugged into the computer.

1. From the Tools tab in OVRD, click the ‘Transfer’ button.

The Data Transfer screen displays as shown to the © oo Tt == _ N =g

right. Select the To BOE (New) radio button. Click oyl

‘Browse’ to select the location of the portable media © ToBoSiNen)

device, if needed. Once the database file location is beccrton

selected, click ‘Run’ to export all the Election Day e ming, e 1 s o somte e cous s ara e vy

aCth]ty tO a data flle ‘Sngsfmsry;:;rlg:hnuangar. NQTE: Running this will LOCK the machine from future l
2. The Data Transfer Warning windows displays as s —

shown below. Clicking ‘Yes’ will begin the transfer, File Nome

clicking ‘No’ will cancel the transfer. If the user needs e ——

to retransfer a previously created transfer file, select

‘To BOE (Re-Transfer)’ as the ‘Data Transfer Method'.

Then the user must select the export date of the file to

retransfer. The Transfer to BOE Statistics report will Run

print.

Data Transfer Wamning

l Running the data transfer TO BOE in OVRD can only be performed

% once.
After running this process, the election functionality will be locked en
this machine, preventing any voting.
Do you wish to continue to transfer the data?

.

3. Verify the file name listed in the ‘File Name’ field exists in the location selected.
4. Transfer the USB drive with the OVRD data file back to the county office.
5. Follow the steps for Import Data at the County BOE, except replace one-stop file with an OVRD file.
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CHAPTER 6: REPORTS

SECTION 1: OVERVIEW

This chapter discusses the three reports available from the OVRD application.

SECTION 2: OVRD VOTING REPORTS

In OVRD, there are three reports that produce either statistics or detail for all activity that has occurred on a
particular machine: the OVRD Transaction Statistics report, the OVRD Voter Detail report and the OVRD
Provisional Poll Book. To access these reports in OVRD, select the Tools ribbon and select either ‘OVRD
Transaction Statistics’, ‘OVRD Voter Detail’ or ‘OVRD Provisional Poll Book’ from the Reports box.

Home Tools
» ol OVRD Transaction Statistics =
GeSx = ) = &
5| OVRD Voter Detail = 7 7
Street Local Other Post-Election Scan Absentee Transfer  Status

Search  Site Site =) OVRD Provisional Poll Book ¥ Audit Vioters -

Lookup Reports Ukilities Data Transfer

OVRD TRANSACTION STATISTICS REPORT

The OVRD Transaction Statistics report gives a summary count of the following information with precinct and
machine: votes cast, cancelled votes, actual votes, and updated registrations.

A sample of the report can be seen below.

OMSLOW COUNTY BOARD OF ELECTIONS

OVRD TRANSACTION STATISTICS

Machine All Votes Cancels Actual Votes  Updated Provisionals
tanvolze-Canceitl  Repistrations

Precinct ENO3

SBEBWKIZRM 132

ra
(=]
P

(=]
[=]
&

Total:

To print the report to the default printer, click the small printer icon (2r from | OSV Report Viewer
the left). __

& |3 By
Main Report
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OVRD VOTER DETAIL REPORT

The OVRD Voter Detail report gives a list of voters with some of their registration/vote data. The data

includes name, VRN, residential address, vote type, ballot number, party, party voted, vote date, age, gender,
race, site, and machine.

A sample of the report can be seen below.

ONSLOWCOUNTY BOARD OF ELECTIONS
OVRDVOTER DETAIL

Name/VRN

Address

VoteType BallotNumber Party Vote Date Apge Gender Race Election Site  Machine
APPLE, MARY SUSAN 108 ROEINHOCD DR v 00000004  REP(RER) 11/08/2013 71 F WHITE ENOD3 SBEWKOZ
JACKSONVILLE, NC 28546
000000044418
APPLETON,JADE 107 ALTAVISTA LOGR v 00000002 REP(RER) 11/08/2013 51 F WHITE ENOD3 SBEWKOZ
ASHLEY JACKSONVILLE, NC 28546
000000405622
TATE,RODNEY 30T LAKEWOOD DR v 00000001 UNA{UMNA) 11/08/2013 54 M BLACKor ENOD3 SBEWKOZ
QUINTELL JACKEONVILLE, NC 28546 AFRICAN
000000350404
Votes: 3
Cancels: 0

ActualVotes: 3

To print the report to the default printer, click the small printer icon (224 from

the left).

4

ol OS5V Report Viewer

g

=
Main Repoart

i

OVRD PROVISIONAL POLL BOOK

The OVRD Provisional Poll Book report is a detailed listing of the provisional voting information logged on a
particular machine. The report displays the poll book number, voter name and address, ballot style issued and
the PIN number for a provisional voter.

To run the report, select OVRD Provisional Poll Book from the Reports section of the Tools ribbon.

Home
-
e ®

Street Local Other
Search  Site Site

8-
[ fie
@

Lockup
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Toals
i OVRD Transaction Statistics

5| OVRD Voter Detail

= i n
5| OVRD Provisional Poll Book ﬁ

Scan Absentee

Reports

Utilities

g

Transfer
Voters =

8

atatus

Data Transfer

-43 -



The report will display as shown below.

MECKLENBURG COUNTY BOARD OF ELECTIONS

OVRD PROVISIONAL POLL BOOK

Precinct: 200
Machine 1D: 400
Election: 03/24/2015 PRIMARY

2210 CATALINA AVE
CHARLOTTE, NC 2206

GrandTotal: 2

To print the report to the default printer, click the small printer icon (2nd from
the left).

OVRD User Guide

Count FollBook No. Voter Mame/Address Ballot Style Issued FINNumber
200-400-1 DOG, ODIE THE Did01 CWEI400-1
8626 CATFISH DR
CHARLOTTE, NC 28214
z 200-400-2 WORTHINGTON, EMILY MAE RO02 CWEZ-400-2

r

al OS5V Report Viewer

& (S Ry
Main Report
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CHAPTER 7: TOOLS

SECTION 1: OVERVIEW

This chapter discusses several tools available to the user: the street search, change a password, site and
machine information, post-election audit export, flagging voters as transfers, and flagging or scanning voters

as absentee.

SECTION 2: STREET SEARCH

The Street Search tool is used to determine the jurisdiction and ballot style information of a selected street.
This is useful for looking up ballot styles for specific addresses, especially for provisional voting. Follow the

steps below to perform a street search.

1. Select the Tools ribbon and then
click ‘Street Search’. The Street
Search screen will appear, as shown
to the right.

Select or enter data in any criteria
field that may help find the street;
typically, this is the street name
field. The criteria fields include:
‘House #’, ‘Direction’, ‘Street Name’,
‘Type’, ‘Suffix’, ‘City’, ‘State’, and ‘Zip
Code’.

Click the ‘Search’ button. The
results will display in the Streets
grid section of the Street Search

screen with plus (+) signs next to
them. When the plus (+) sign is
clicked, it will expand the results
and display all of the detailed
information, as shown to the
right. The detailed information
for a row shows all of the
jurisdictions tied to the street, as
well as ballot style information
broken out by Party, Age and
Ballot Style. If the ‘Expand All’
button is clicked, the detailed
jurisdiction and ballot
information for all results in the
grid will display. If the ‘Collapse
All’ button is clicked, the detailed
information will be hidden.
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e sxreet Search =]
| Search Critena
Houso# Dimction  Stroot Namo Typo i City State 2IP Cade
: .
Cloar |
Streets
LN Close_|
Mo crect Search = B X
Search Criteria
House# Direction  Street Name Type Suffix City State ZIP Code
Clear
Streets (2 rows)
Low House # High House # Side  Direction Street Name Type Suffix City State  ZIPCode
=Y o 8 3 GOLDFINCH LN MILL SPRING NC 28756
PCT MUNI WARD CONG SUPCT JUD NCSEN NCHSE CCOM TWP SCHL FIRE WATERSEWER SANI RESC MDST PRSC VID
| caos | [10 |28 |28 |47 |m3 | | | | | | | | | |28 |cGos |
Party Age Ballot Siyle
DEM 17 NO BALLOT
DEM 18+ NO BALLOT
LB 17 NO BALLOT
Lig 18+ NO BALLOT
REP 17 NO BALLOT
REP 18+ NO BALLOT
UNA 7 NO BALLOT
UNA 18+ NO BALLOT
Low House # High House # Side  Direction Street Name Type Suffx City State  ZIPCode
L 5 0 GOLDFINCH LN MILL SPRING NC 28756
|
Expand All Caollapse All Clase




SECTION 3: CHANGE PASSWORD OPTION

OVRD provides the ability for a user to change their password, should they need it. If the user does not know
their password to log in to OVRD, another user with supervisory privileges can change the password for them.
By default, a user’s password is set during the set-up process of the Wizard in One-Stop System Manager. Itis
recommended to change the password after the first login to ensure that secure passwords are being used.
The user must have the Change Password permission to enable the change password functionality.

The following steps describe how a user can change their Sl 2
password.

Login Name

1. Click on File 2 Information Change Password. The i

change password screen appears, as shown to the right.
MNew Password

2. Enter the new password in the New Password field. Enter
the same password into the Confirm New Password. Click Confirm New Password
‘Change Password’ to put the new password into use.

Please keep in mind that passwords are case sensitive. Be ng:&%?d Gancel
sure to use upper and lower case where necessary.

If the user has supervisory privileges, the login name field

will have a drop-down list of users that can be reset. The ‘Reset Password’ button will be used by
supervisors only. To change another user’s password, select the ‘Login Name’ from the drop-down
and click ‘Reset Password’. This will reset the user’s password to the system default.

SECTION 4: SITE INFORMATION

OVRD provides site information in three ways through the File menu and Tools ribbon. These items will
allow the user to find out information about the site to which the machine is currently set, other Election Day
voting sites within the county, as well as information about the current machine. To access the ‘Local Site
Information: <XXX>'" (where XXX is the precinct of the current machine) and ‘Other Election Sites‘ select the
Tools ribbon and then click’ Local Site’ or ‘Other Site’. To access the local machine information, click File>
Information—>Machine Information.

LOCAL SITE INFORMATION

Local Site Information gives the user address and contact [ @ (ocai brection Site Information: TR123 52
detail for the Election Day site for the current machine.
Access to this tool is from the Tools ribbon (Tools 2

Local Site and will display the screen shown to the right. Site Abbreviation: TR123

In the sample, the OVRD machine was set to precinct Address o e varas
“TR123”. A ‘Print’ button is available to print the site Election Day Contact

information.

Election Site Name: | HARMON FIELD LOG CABIN

Home Phone Number:
Work Phone Number:

Cell Phone Number:
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OTHER SITE INFORMATION

Other Election Sites gives the user address and contact

@ Other Election Site Information 2
detail for other Election Day sites within the county.
Access to this tool is from the Tools ribbon (Tools = Other Election Site Name: |FARMONFIELDLOG CABIN -
Site) and will display the screen shown to the right. To SeAbbrer el
view information for other sites, simply select the site Address: 259 HARMON FIELD RD

. . . . TRYON. NC 28782
from the drop-down list. A ‘Print’ button is available to

. . . . Election Day Contact:
print the site information.

Home Phone Number:
Work Phone Number:

Cell Phone Number:

MACHINE INFORMATION

Machine Information gives the user details about the local @i voingiomason
machine. Access to this tool is from the File menu (File >

o

Information ?Machine Information) and will display the FlectionDate.  03710/2015 M
R . . Election Site: SLADESVILLE FIREDEPARTMENT MTG

screen shown to the right. Information that will be ROOM

displayed includes the Election, Site, Machine name, Marrine: ShEWREERED

Machine ID, and Alphabet Range for the OVRD machine. It Sainell =

also shows the MBSN and GUID of the machine as well as AlphabetRange: A-Z

any ‘Status’ messages. If Provisional Voting is enabled, a ‘Y’ MBSN:  2UAB20THOX S

. [
. . . . . GUID: 00000000-0000-0000-0000-000000000000 Allowed:
indicator will appear on the right side of the screen. v

Status
No current ssues.

SECTION 5: EXPORT DATA FOR POST ELECTION AUDIT

This function on the Tools ribbon is an administrative function used to retrieve any One-Stop votes that may
have been left behind on the machine before Election Day. This function might be used if the administrator
determines that they did not receive all of the One-Stop vote data from that machine before it was converted
to OVRD.

To perform the Export of Post Election Audit data, click Tools 2 Post Election Audit. Set the location to the
USB drive by clicking the ‘Browse’ button. Click the ‘Run’ button to save the file to the specified location.
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SECTION 6: FLAG AS TRANSFERRED

With OVRD'’s Election Day Flag as Transfer function, the user will have the ability to mark a person as “voted”

if a pollworker from another election site calls and states that a voter has voted at their site. This helps to

prevent any duplicate voting within the county. Transfers are only allowed if the option was set during the

Wizard to allow them.

For the case where a voter has voted at another election site, do the
following steps to mark them as transferred:

1. Search for the registrant. When found, select their record and
click on Home Flag as Transfer.

2. The screen to the right will display. Select the precinct they
voted in (the one calling you) and click the ‘Select’ button.

After the save, the lower section will display the following:

@ Voted Precinct

Please selectthe Precinctwhere this registrant voted.

ALBEMARLE ROAD ELEMENTARY SCHOOL - MULT.
ALBEMARLE ROAD PRESBYTERIAN CHURCH - GYM
ALBEMARLE ROAD RECREATION CENTER - GYM

ALDERSGATE UNITED METHODIST CHURCH - FEL

ALEXANDER GRAHAM MIDDLE SCHOOL - MULTI-P..

ALLENBROOK ELEMENTARY SCHOOL - MULTI-PU..

AMITY PRESBYTERIAN CHURCH - FELLOWSHIP H..
AVONDALE PRESBYTERIAN CHURCH - FAMILY LIF.

BACK CREEK PRESBYTERIAN CHURCH - GYM

BARRINGER ACADEMIC CENTER - MULTI-PURPOS..

BELLE JOHNSTON COMMUNITY CENTER - GYM

BEN SALEM PRESBYTERIAN CHURCH - FELLOWS .

BERRYHILL BAPTIST CHURCH - FELLOWSHIP HALL
BETHEL PRESBYTERIAN CHURCH- GYM
BETTE RAE THOMAS RECREATION CENTER - GYM

BEVERLY WOODS ELEMENTARY SCHOQL - GYM

‘ ‘ | Cancel

VRN: 001000240205 ACTIVE 200/200

Voter

8622 CATFISHDR
CHARLOTTE. NC 28214

| Changes

Election Date:
Voted Date:
Ballot Style:
PCT/VTD:
Ballot ID:

CANNOT VOTE e
CAT, GARFIELD THE TRANSFERRED TO 204.1 PRECINCT

3/24/2015

If the user has made a mistake in flagging the voter as Transferred, simply search for and select the voter

again, and click Home 2Unflag as Transfer. The information in the bottom section of the screen will be

removed, and the voter is no longer considered a transfer.

SECTION 7: FLAG AS ABSENTEE

With OVRD'’s Flag as Absentee function, the user will be able to mark a person as having voted absentee. This
is useful if the machines were sent to the polls over the weekend and absentee ballots came in after that time.
If a data update to the machine via ‘Data Transfer’ is not possible, this is a quick way to update voters on the

OVRD machines.

To flag a voter as having voted Absentee:

1. Search for the registrant. When found, select their record and click on Home Flag as Absentee.
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2. Once ‘Flag Selected Voter as Absentee’ is clicked, the lower section will display the following:

E VRN 001000240205  ACTIVE 200/200 CANNOT VOTE e
> CAT, GARFIELD THE FLAGGED AS VOTED ABSENTEE
@] 8622 CATFISHDR : s
°g’J CHARLOTTE. NC 28214 Sl o G
a Ballot Style:
PCTVTD:
‘ Ballot ID:

If a mistake was made in flagging this voter as Absentee, simply search for and select the voter again, and click
Home 2Unflag as Absentee. The information in the bottom section of the screen will be removed, and the
voter is no longer considered voted absentee.

SECTION 8: SCAN AS ABSENTEE

With OVRD’s Scan as Absentee function, the user will be able scan barcodes of registrants that voted absentee.
This is useful if the machines were sent to the polls over the weekend and absentee ballots came in after that

time. If a data update to the machine via ‘Data Transfer’ is not possible, this is a quick way to update voters on
the OVRD machines.

To scan multiple voters as having voted absentee: Scan Absentee Voters = Py
Enterthe Voter Registration Number of any registered
1. InReport Manager run the Absentee BaHOt_S voterthat voled a valid absentee ballot since the last
Executed VRN Barcode report for the election and "FROM BOE" on this machine.
ballot return date (use a date range to pull only These voters will be flagged as having voted absentee
those that returned ballots AFTER the end of One- and will not be allowed to vote on Election Day.
Stop voting). Print the report. T
2. Grab the barcode scanner and the report and in

OVRD, click Tools 2Scan Absentee Voters. The

window to the right will display.

3. Scan the first barcode (or type the VRN and click :
‘Submit’), and then continue scanning all absentees that need to be scanned.

No message or indication will appear on-screen that they were flagged, but if the voter is searched for
after the scanning is complete, they will show “Flagged as Voted Absentee”.

£ VRN: 001000240205  ACTIVE 200/200 CANNOT VOTE e
> CAT, GARFIELD THE FLAGGED AS VOTED ABSENTEE
@] 8622 CATFISHDR - .
°g”| CHARLOTTE. NC 28214 EL‘;CEEDD” ﬂ[t’::‘e' /242015
a Ballt Style:
PCTVTD:
‘ Ballot ID

If a mistake was made when scanning any voter as Absentee, simply search for and select the voter again, and

click Tools ?Unflag as Absentee. The information in the bottom section of the screen will be removed, and the
voter is no longer considered voted absentee.
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DOCUMENT CHANGES LOG

DATE CHANGES MADE

10/18/2013 Created Document based on SOSA document.

10/21/2013 Updated formatting to match SOSA manuals.
Updated text to be accurate for OVRD.

10/22/2013 Further modifications to screenshot positioning.
Fixed formatting to match SOSA admin guide formatting.

11/04/2013 Fixed up several formatting/spelling/grammar issues.

11/15/2013 Fixed up formatting issues and made changes to several sections, adding new information as
well

12/9/2013 Major updates to all chapters for new layout and functionality

1/9/2014 Updated title issue and update date

02/09/2015 Updated entire document to add Provisional voting functionality. Screenshots were updated
as well.

04/17/2015 Minor updates to remove remaining references to SDR and other typos.

07/24/2015 Updated screenshots on multiple pages. Fixed references to Transfer items that moved to the
Tools tab. Added 2D Barcode Scanning section.

12/17/2015 Changed references to CONNECTED, HYBRID and DISCONNECTED to COUNTY and LOCAL.
Also updated corresponding screenshots.

12/28/2015 updated screenshot and table to add new button "Print Referral”
updated ID Documents List and screenshot

added bullets regarding new buttons-Vote Provisional and Print Referral.

updated provisional screenshots and added sections regarding printing an Acknowledgment
of Voting Options form and using the Curbside checkbox and the Reasonable Impediment
radio button
added screenshots for 2 new DL Expired messages
added info regarding new buttons-Vote Provisional and Print Referral. Added Note regarding
Religious Objection flag (checkbox).
updated transfer status screenshot as well as all other screenshots that needed to be updated

01/13/2016 Multiple updates to screenshots and text based on development suggestions/review. Added
section for help referral form.

04/15/2016 Updated screenshots for changes to ribbon icons and updated button names throughout
document

07/21/2016 Updated screenshots throughout as necessary. Added information to NCDL barcode scanning
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regarding auto-population of voter data.

08/25/2016 Updated help referral form screenshot

08/30/2016 Removed references to Reasonable Impediment
01/27/2017 Updated text and screenshot on page 6

06/29/2017 Updated screenshots and made minor edits throughout
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